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Using This Guide

Welcome to Avid Xpress® DV! This guide provides you with information 
about how to start using your Avid Xpress DV system. It presents 
instructions for setting up your system and a step-by-step tutorial for 
creating a short video sequence.

n The documentation describes the features and hardware of all models. 
Therefore, your system might not contain certain features and hardware 
that are covered in the documentation. 

Who Should Use This Guide

This guide is written for anyone who is familiar with a Windows® or 
Macintosh® computer system. You do not need video editing experience to 
use this guide. If you are an experienced digital, nonlinear editor, you can 
use this guide to learn about basic Avid Xpress DV features and to 
complete the tutorial. 

About This Guide

This guide describes the basic features of the Avid Xpress DV system. For 
more information on using Avid Xpress DV, see the Avid Xpress DV 
User’s Guide, Help, and other guides listed in “Related Information” on 
page 18.
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This guide has the following overall structure:

• Chapter 1 describes how to set up your Avid Xpress DV system and 
prepare drives on a Windows XP and a Mac® OS X operating system.

• Chapter 2 describes how to install the product software and the tutorial 
media.

• Chapter 3 presents the basic editing concepts and walks you through a 
typical workflow scenario.

• Chapter 4 details how to use the Avid Xpress DV tutorial, Help system, 
and documentation.

• The remaining chapters present step-by-step instructions for the most 
important tasks involved in editing and outputting a digital video 
sequence.

• Finally, a detailed Index helps you quickly locate specific topics.

Symbols and Conventions

Unless noted otherwise, the material in this document applies to the 
Windows XP and Mac OS X operating systems. When the text applies to a 
specific operating system, it is marked as follows:

• (Windows) or (Windows only) means the information applies to the 
Windows XP operating system.

• (Macintosh) or (Macintosh only) means the information applies to the 
Mac OS X operating system.

The majority of screen shots in this document were captured on a 
Windows XP system, but the information applies to both Windows XP and 
Mac OS X systems. Where differences exist, both Windows XP and
Mac OS X screen shots are shown.
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The Avid Xpress DV documentation uses the following special symbols 
and conventions:

1. Numbered lists, when the order of the items is important.

a. Alphabetical lists, when the order of secondary items is important.

• Bulleted lists, when the order of the items is unimportant.

- Indented dashed lists, when the order of secondary items is 
unimportant.

t One arrow indicates a single-step procedure. Multiple arrows in a list 
indicate that you perform one of the actions listed.

The k symbol refers to the Apple or Command key. Press and hold the 
Command key and another key to perform a keyboard shortcut.

Courier Bold font identifies text that you type.

Look here in the 
margin for tips.

In the margin, you will find tips that help you perform tasks more easily 
and efficiently.

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

c A caution means that a specific action you take could cause harm to 
your computer or cause you to lose data.

w A warning describes an action that could cause you physical harm. 
Follow the guidelines in this guide or on the unit itself when handling 
electrical equipment.
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If You Need Help

If you are having trouble using Avid Xpress DV:

1. Retry the action, carefully following the instructions given for that task 
in this guide. It is especially important to check each step of your 
workflow.

2. Check the release notes supplied with your Avid application for the 
latest information that might have become available after the hardcopy 
documentation was printed.

3. Check the documentation that came with your Avid application or your 
hardware for maintenance or hardware-related issues.

4. Visit the online Knowledge Center at www.avid.com/support. Online 
services are available 24 hours per day, 7 days per week. Search this 
online Knowledge Center to find answers, to view error messages, to 
access troubleshooting tips, to download updates, and to read/join 
online message-board discussions.

5. For Technical Support, please call 800-800-AVID (800-800-2843).

For Broadcast On-Air Sites and Call Letter Stations, call
800-NEWSDNG (800-639-7364).

Related Information

After learning the basics about Avid Xpress DV in this guide, consult the 
following for information about all product features:

• Avid Xpress DV Release 3.5 Release Notes for the Mac OS X 
Operating System

The release notes include important information you should read 
before installing and using Avid Xpress DV on a Mac OS X system.

• Avid Xpress DV Release 3.5 Release Notes for the Windows XP 
Operating System

The release notes include important information you should read 
before installing and using Avid Xpress DV on a Windows XP system.
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• Avid Xpress DV User’s Guide

This guide provides complete information on all editing tasks, such as 
recording footage, viewing and marking footage, editing, trimming, 
importing, exporting, and generating final output. 

• Avid Xpress DV Effects Guide

This guide describes techniques for using digital video effects, titles, 
third-party effect filters, mattes, keys, paint effects, and layering 
options. 

• Avid Color Correction User’s Guide

This guide provides information about the Avid Color Correction tool 
that allows you to:

- Adjust color attributes such as hue, saturation, gain, and gamma

- Control the relationship between input and output color

- Set limits on color levels

- Display waveform and vectorscope information

The Avid Xpress DV Online Publications CD-ROM includes a color 
version of this guide.

• Avid Xpress DV Help

The Help system includes online, hypertext information for using all 
product features. It provides all the information included in the 
Avid Xpress DV User’s Guide, the Avid Xpress DV Effects Guide, and 
the Avid Color Correction User’s Guide supplied with your system.

• Avid Xpress DV Quick Reference for the Mac OS X Operating System

This folded card lists convenient Macintosh keyboard shortcuts.

• Avid Xpress DV Quick Reference for the Windows XP Operating 
System

This folded card lists convenient Windows keyboard shortcuts.

• Avid Xpress DV User’s Guide Supplement (.pdf only)

This document contains information about AudioSuite plug-ins, File 
Format specifications, and Avid Log Exchange specifications.
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• Avid Xpress DV Online Publications CD-ROM

This online collection provides electronic versions of this guide, the 
Glossary, and other guides listed in this section. You can view these 
documents with Adobe® Acrobat® Reader®, which you can install 
from the CD-ROM. The collection also includes the Avid Xpress DV 
Tour, the Avid Xpress DV Help, the Avid EDL Manager User’s Guide, 
the Avid FilmScribe User’s Guide (available as an option), the Avid 
IllusionFX Guide (available as an option), and the Avid Xpress DV 
User’s Guide Supplement.

If You Have Documentation Comments

Avid Technology continuously seeks to improve its documentation. We 
value your comments about this guide, the Help, the Online Publications 
CD-ROM, and other Avid-supplied documentation.

Simply e-mail your documentation comments to Avid Technology at 

TechPubs@avid.com

Please include the title of the document, its part number, revision, and the 
specific section you are commenting on in all correspondence. 

How to Order Documentation

To order additional copies of this documentation from within the 
United States, call Avid Sales at 800-949-AVID (800-949-2843). If you are 
placing an order from outside the United States, contact your local Avid 
representative.

Avid Educational Services

For information on courses/schedules, training centers, certifications, 
courseware, and books, please visit www.avid.com/training or call 
Avid Sales at 800-949-AVID (800-949-2843).



Chapter 1

Setting Up Your 
Avid Xpress DV System

This chapter describes how to set up your Avid Xpress DV system and 
contains the following sections:

• Overview

• Check List for Setting Up Your System

• Turning On Your Equipment

• Installing Boards Purchased Separately

• Connecting the Application Key

• Preparing Your Drives (Windows)

• Preparing Your Drives (Macintosh)

• Setting Your Screen Resolution (Windows Only)

n FireWire® is a peripheral standard for transmitting data invented by Apple 
Computer, Inc. The standard has become a cross-platform industry 
standard called IEEE® 1394. Sony Corporation also uses the IEEE 1394 
standard and calls it i.LINK®. The transmission standard is referred to as 
IEEE 1394 (1394) in this document.
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Overview

Congratulations! You are about to set up your Avid Xpress DV system. 
Your Avid Xpress DV hardware might consist of:

• A supported desktop or laptop system, running the Windows XP 
operating system that contains a supported 1394 capture board (1394 
board) with OHCI compliance using the Texas Instruments (TI™) chip

• A supported Macintosh system running the Mac OS X operating 
system

Determining Supported Equipment

The supported desktop systems, laptop systems, Macintosh systems, 1394 
boards, and SCSI boards are listed on the Avid® Web site.

1. Go to www.avid.com, and then click Products.

2. Choose Avid Xpress DV from the product lists that appear, and then 
click Specifications.

n You need to go to this Web site because the supported equipment changes 
more frequently than this document is published, and you have probably 
already purchased the equipment.

Purchasing the Equipment

The system can be purchased in one of two ways as follows:

t Purchase a system through an Avid Reseller with the hardware and 
software already installed. 

t Purchase the system yourself from a system vendor other than Avid, 
and purchase a “software only” kit from Avid that contains the 
software, documentation, and application key (dongle). In this case, 
you are responsible for installing the hardware and software using the 
documentation provided by the system vendor and Avid respectively. 
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Check List for Setting Up Your System

The check list in Table 1 lists the tasks you need to complete before you 
can use your Avid Xpress DV system. 

Table 1 Check List for Setting Up Your System 

To See

Set up your computer hardware: 
computer, monitor, mouse, keyboard, and speakers

Instructions shipped with the computer

Turn on your equipment “Turning On Your Equipment” on page 24

Install boards purchased separately (1394 and PCI 
SCSI)

“Installing Boards Purchased Separately” on 
page 25

Connect the application key “Connecting the Application Key” on page 26

Prepare your drives “Preparing Your Drives (Windows)” on 
page 27 and “Preparing Your Drives 
(Macintosh)” on page 36

Install Avid Xpress DV software “Installing Avid Xpress DV Software 
(Windows)” on page 40

Create an emergency repair floppy disk “Creating an Emergency Repair Floppy Disk 
(Windows Only)” on page 61

Install the Avid Xpress DV tutorial files (optional) “Installing the Avid Xpress DV Tutorial Files 
(Windows)” on page 50 and “Installing the 
Avid Xpress DV Tutorial Files (Macintosh)” on 
page 60

Connect your camera, digital video deck, or 
transcoder (you can connect these after you install 
the software if you prefer)

“Connecting a Computer Without a Client 
Monitor” on page 66
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Turning On Your Equipment

After you have connected the monitor, mouse, keyboard, and speakers (if 
ordered) using the documentation provided by the vendor, turn on the 
various components. You need to do this to make sure your system works 
properly before you install any new hardware or Avid software. If your 
system works before you install the hardware, but not after you install the 
hardware, you know where to start troubleshooting.

If any part of your system fails to turn on, make sure its electrical cord is 
plugged snugly into an appropriate electrical outlet or power strip. For 
more information, see the instructions for setting up your computer 
hardware. 

To check the system before you install the hardware:

1. Turn on all peripheral units, such as the monitor and speakers. 

n If for any reason you have external drives attached to the system, you 
should also turn them on.

2. Turn on your computer.

n If this is the first time the computer has been turned on, you might have to 
answer questions related to the licensing and setup of the operating 
system. 

For information on 
your operating system 
features, such as the 
desktop and icons, see 
your computer system
documentation.

3. When you see the logon screen, do not type a password, just press 
Enter (Windows) or Return (Macintosh) and the desktop appears.

4. Do any type of basic computer operations like checking the disks or 
running any program to see if the system seems to be working 
properly.

5. Shut the system down. 
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Installing Boards Purchased Separately

The following sections explain where to find installation instructions if you 
have purchased supported versions of a separate 1394 board and a separate 
PCI SCSI board.

n The operating system will use its plug-and-play capability to install the 
software for the boards the first time you turn on the system after the 
boards are installed. If the software is not available on the system disk and 
installed automatically, a software installation wizard appears. You should 
follow the instructions provided by the wizard to install the software for the 
boards from the CD-ROM or floppy disk provided with the board.

Installing the 1394 Capture Board

If you purchased the 1394 board separately and you have tested your 
system, as explained in “Turning On Your Equipment” on page 24, you 
should turn off your system and install the supported 1394 capture board 
(1394 board). The 1394 board can be either a PCI version or a PCMCIA 
version that is OHCI compliant and uses the Texas Instruments (TI) chip. 

n If you have purchased a supported Macintosh system, you do not have to 
install a separate 1394 board into the system. Your Macintosh system has 
built-in 1394 ports at the front or rear of the system.

n You might not need to install a 1394 board into your system if Avid 
supports a desktop or laptop system that has a built-in 1394 connection. 

You should follow the instructions in the documentation that ships with 
your computer to install the 1394 board into the computer. At this time, 
there is no specific PCI slot assignment for the 1394 board in desktop 
computers.

n If you have purchased one of the 1394 boards supported by Avid, a new 
driver for the board will be installed with the Avid Xpress DV software.



 Chapter 1 Setting Up Your Avid Xpress DV System

26

Installing the PCI SCSI Board

If you have purchased a supported PCI version of a SCSI board and you 
have tested your system, as explained in “Turning On Your Equipment” on 
page 24, you should turn off your system and install the supported PCI 
SCSI board. At this time, the only PCI SCSI board Avid supports is the 
Adaptec™ 29160 board. Different boards might be supported at a later 
date. 

You should follow the instructions in the documentation that ships with 
your computer to install the PCI SCSI board into the computer. At this 
time, there is no specific PCI slot assignment for the PCI SCSI board in 
desktop computers. See “Preparing Your Drives (Windows)” on page 27 
for more disk information. 

Connecting the Application Key

The application key, commonly referred to as a dongle, allows 
Avid Xpress DV software to run on your computer. You must connect the 
application key to a USB port on the computer. The computer sees the 
application key when it is booting. If you connect the application key after 
you boot the computer, you must reboot the computer. Figure 1 shows the 
application key.

n Application keys cannot be moved between Windows and Macintosh 
systems.

Figure 1 Application Key 

c Be careful you do not lose the application key. Your Avid Xpress DV 
software does not function without it. If you lose your application key, 
you must purchase another key from Avid at the full market cost of 
your Avid Xpress DV software.
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Preparing Your Drives (Windows)

There are two types of disk drives defined by the Windows operating 
system:

• Basic — Disk drives allow disks to be divided into partitions. This 
type of drive is supported by Avid.

• Dynamic — Disk drives allow disks to be divided into volumes. Disk 
drives must be Dynamic if you want to stripe, mirror, or use disks in 
the RAID style. Avid does not support the use of Dynamic disks.

To use Avid Xpress DV software on your system, your drives need to be 
partitioned and formatted properly. Partitioning allows you to divide a 
drive into more than one section if needed, and formatting places a file 
system on each partition. 

Your computer always contains a disk drive that is already at least partially 
partitioned and formatted (see “Checking Your Internal Drives (Windows 
Only)” on page 30). This partition contains the operating system. That’s 
why the operating system appears automatically when you turn on the 
computer.

The remaining portion of the first drive and the second drive might already 
be partitioned or they might be left unallocated. 

This section includes the following information:

• Overview of Partitioning Basic Drives (Windows Only)

• Supported File Systems (Windows Only)

• Checking Your Internal Drives (Windows Only)

• Creating Primary Partitions and Formatting (Windows Only)

• Testing Drives (Windows Only)
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Overview of Partitioning Basic Drives (Windows Only)

Your operating system allows you to create multiple partitions on a single 
physical drive as a way to manage projects and files. The following are two 
ways Avid supports drive partitioning. 

The letters G through J 
used are examples only.

• You can partition your drive as one primary partition, having the 
partition represented by a drive letter. 

• You can have up to four primary partitions per drive. Each partition is 
assigned a drive letter and cannot be further subdivided.

For specific recommendations for partitioning your drives, see “Creating 
Primary Partitions and Formatting (Windows Only)” on page 32. 

n The Computer Management window has a text frame that describes each 
partition as a “Volume laid out as a partition” (see “Checking Your 
Internal Drives (Windows Only)” on page 30). See the Help icon in the 
toolbar of the Computer Management window for any information 
regarding disk usage in the Windows operating system.

G

One partition

Drive G

G H I J

Four partitions

Drives G – J
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Supported File Systems (Windows Only)

Your operating system supports three types of file systems: 

• Two types of the File Allocation Table (FAT); FAT 16 and FAT 32. FAT 
is primarily used when backward compatibility is needed on operating 
systems such as MS-DOS® or other versions of Windows. The new 
FAT 32 file system is no longer limited to a 2-GB partition size. Avid 
supports the FAT 32 file system.

• The New Technology File System (NTFS). NTFS affords the user 
security, compression, and other file recovery features. Drives 
employing NTFS support partitions of any size. Avid supports the 
NTFS file system.

When you partition your drives Avid recommends:

t Choosing NTFS from the pop-up menu when you partition your disk 
drives for use on desktop computers. 

t Choosing FAT 32 from the pop-up menu when you partition your disk 
drives for use on laptop computers. 

c One of your internal disk drives (normally designated drive C) has a 
partition that contains the operating system. This drive might be 
labeled System or Boot. You should not reformat this partition unless 
you need to rebuild your system disk drive. 
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Checking Your Internal Drives (Windows Only)

You might have one or two internal drives in your desktop or laptop 
computer. Depending on how you purchased your desktop computer, the 
internal drives might be set up using different formats (laptops normally 
only use a FAT 32 file system). A desktop computer is used as an example 
in this section.

• The first drive might have a 2-GB partition that is formatted with a 
FAT 32 file system or an NTFS partition. This partition is your system 
or boot drive, which is normally designated drive C in the factory 
default configuration. The remaining portion of this drive might need 
to be partitioned and formatted before you install Avid Xpress DV 
software. 

• The first drive might have one large NTFS partition, but this partition 
would still be your system or boot drive and is normally designated 
drive C in the factory default configuration. 

• The second drive is intended to be used as a media drive. This drive 
might already be partitioned and formatted, or you might need to 
partition and format this drive as well.

To check your internal drives:

1. Start your system and log in to an account with administrative 
privileges. 

2. Click the Start button, point to Settings, and select Control Panel. The 
Control Panel window opens.

3. Double-click Administrative Tools.

4. Double-click Computer Management. The Computer Management 
window opens. 

5. Double-click the Disk Management folder (see Figure 2). Depending 
on the size of the window that opens, you might want to click the 
Maximize button in the upper right corner of the window.

Figure 2 shows an example of the Computer Management window 
with the Disk Management folder selected.
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Figure 2 Computer Management Window

6. Look at Disk 0 and Disk 1 in the Graphics frame. 

The same information 
shown in the Graphics 
frame can be seen in 
text format in the Text 
frame.

- Your Disk 0 might look similar to Disk 0 in Figure 2. The Text 
frame defines each section of Disk 0 as Volumes with an assigned 
letter and commonly referred to as partitions. The Graphics frame 
shows that Partition C on Disk 0 has a blue stripe across the top 
defining it as a Primary Partition and as a 2-GB FAT file system. 
The partition also shows the status of the partition as Healthy and 
that it is the System (or Boot) disk.

c You should not partition and format the partition that contains the 
operating system (labeled System or Boot). In the factory default 
configuration this partition might be designated as drive C, as shown 
in Figure 2.

Disk 
Management
folder

Maximize button

Disk 0 and Disk 1 Disk definition

Text frame

Graphics frame
Volume laid out
as a partition

Help icon



 Chapter 1 Setting Up Your Avid Xpress DV System

32

The remaining section 
of your Disk 0 might 
not be partitioned. You 
should partition all 
unallocated disks or 
unallocated portions of 
disks.

The remaining portion of Disk 0 (as shown in Figure 2) contains:

• A Primary partition labeled E.

• An NTFS file system.

• A Healthy partition with a Page File on the partition.

- Your Disk 1 might look similar to Disk 1 in Figure 2. The figure 
shows Disk 1 with a black stripe across the top defining it as an 
Unallocated Partition with no file system. Since the disk is 
unallocated (not partitioned) there is no status.

Any unallocated space should be partitioned and formatted for use.

Creating Primary Partitions and Formatting (Windows Only)

If you need to partition, format, or perform any action on the disks, you 
should click the disk (partition or unallocated disk). When you click the 
disk, the white section of the disk changes to stripes (as shown on 
Partition C of Figure 2) showing that the section has been selected. 

n This section explains how to partition and format Disk 1. The same actions 
can be used to partition and format any unallocated section of disks in 
your system.

To create a primary partition and format Disk 1:

1. Start your system and log in to an account with administrative 
privileges. 

2. Click the Start button, point to Settings, and select Control Panel. The 
Control Panel window opens.

3. Double-click Administrative Tools.

4. Double-click Computer Management. The Computer Management 
window opens (see Figure 3).

5. Double-click the Disk Management folder.
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Figure 3 Partitioning in the Computer Management Window

6. Make sure the disk is designated as a Basic disk before you partition it. 
To designate a disk as Basic:

a. Place the pointer over the physical disk section.

b. Right-click and make sure Basic disk is selected.

7. Place the pointer over Disk 1 (see Figure 3), right-click the mouse, and 
select “Create a partition.”

The Create Partition Wizard window opens and explains the function 
of the wizard.

8. Click Next.

The wizard leads you through partitioning and formatting of the 
selected unallocated section of your disk. Select the following from the 
specified windows: 

- Select Partition Type window — Select Primary and 
click Next.

- Partition Size window — Select Maximum to make the complete 
unallocated space a partition and click Next. To make a smaller 
partition, divide the maximum number by the number of partitions 
you want to make, for a maximum of four partitions per disk. You 
need to run the wizard for each partition.

Disk 1Physical disk section
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- Assign Drive letter — Assign the partition an unused drive letter or 
use the letter automatically selected by the wizard.

- Formatting the partition — You need to make five choices in this 
window (see Figure 4).

Figure 4 Formatting the Partition

Select “Format this partition with the following settings,” and then 
make the following choices:

File system to use — Choose NTFS.

Allocation unit size — Choose Default.

Volume label — Type a label you want for the volume that easily 
identifies the volume.

Select Perform a Quick Format.

9. Click Next. The Completing the Create Partition Wizard window 
opens.

10. The Completing the Create Partition Wizard window provides a list of 
your selections. Check them to make sure you have made the proper 
selections and click Finish (this might take a minute to complete). 

11. Repeat this procedure to partition and format any unallocated disk 
sections.
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Testing Drives (Windows Only)

The operating system contains a disk error-checking program available for 
each disk. 

To run the error-checking program:

1. Start your system and log in to an account with administrative 
privileges. 

2. Click the Start button, point to Settings, and select Control Panel. The 
Control Panel window opens.

3. Double-click Administrative Tools.

4. Double-click Computer Management. The Computer Management 
window opens.

5. Double-click the Disk Management folder.

For an example of the Computer Management window with the Disk 
Management folder open, see Figure 2.

6. Place the pointer over the disk where you want to perform the error 
check, and right-click the mouse.

7. Select Properties.

The Properties window for that device opens.

8. Click the Tool tab. 

9. Click “Check now” in the error-checking frame.

The Check Disk dialog box appears.

10. Click Start. The error-checking program runs and returns the status of 
the disk program.
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Preparing Your Drives (Macintosh)

Avid Xpress DV on a Macintosh system requires Mac OS X. Because of 
this, all drives must be formatted as Mac OS Extended (HFS+). Drives 
formatted HFS can be read, but HFS+ formats are required as media 
drives.

When you attach a new drive to your system it might already be formatted 
as an HFS+ drive. You can find out using the following procedure that 
explains how to format your drive.

To format your drive HFS+:

1. Select your system drive.

2. Choose Utilities from the Applications menu.

3. Double-click Disk Utilities.

The Disk Utility dialog box appears (see Figure 5).

4. Click the Partition tab.

Figure 5 Disk Utility Dialog Box

5. In the Volume Information section give the drive a name, choose 
Mac OS Extended from the Format menu, size the drive, and then click 
OK.
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Setting Your Screen Resolution (Windows Only)

The video playback on your monitor might seem to display improperly 
depending on the type of graphic board you purchase and the selected 
resolution in the monitor display properties. If you change the resolution in 
your monitor display properties, the video playback should display 
properly. Use Table 2 as a starting point for setting your screen resolutions:

n When using a single board to drive two monitors, the maximum resolution 
at which video will play correctly might be limited. If video does not play 
correctly, try reducing the resolution to 2048 x 768.

To change the resolution in your monitor display properties:

1. Right-click the desktop and select Properties.

The Display Properties dialog box appears.

2. Click the Settings tab.

3. Under the Desktop Area, click the slider and drag it to the resolution 
you want, and click OK.

4. Under Colors, select True Colors and click OK.

Repeat this procedure until you have found the correct resolutions needed 
by the Avid software and your graphics board.

Table 2 Monitor Resolutions

One Monitor Two Monitors

1024 x 768 pixels 2048 x 768 pixels

1152 x 864 pixels 2304 x 864 pixels

1280 x 1024 pixels 2560 x 1024 pixels
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Chapter 2

Installing Avid Software and 
Editing Equipment

This chapter explains how to install the Avid Xpress DV software and 
connect the editing equipment to the system. This chapter contains the 
following sections:

• Installing Avid Xpress DV Software (Windows)

• Installing the PowerPack Applications (Windows)

• Installing the Avid Xpress DV Tutorial Files (Windows)

• Installing Avid Xpress DV Software (Macintosh)

• Installing the PowerPack Applications (Macintosh)

• Installing the Avid Xpress DV Tutorial Files (Macintosh)

• Creating an Emergency Repair Floppy Disk (Windows Only)

• Connecting the Editing Equipment

• Assigning a Driver to Your Digital Device (Windows Only)

• Turning Off Your Equipment (Windows)

• Turning Off Your Equipment (Macintosh)
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Installing Avid Xpress DV Software (Windows)

This section describes how to install the Avid Xpress DV application and 
its related components from the installation CD-ROM. 

n In order to install or remove the application software, you need to use an 
account with administrative privileges.

Installing Avid Xpress DV Software and All Components 
(Windows)

To install the Avid Xpress DV software, you must be logged in with 
administrative privileges. To install the Avid Xpress DV software and all 
related components: 

1. Quit all active applications.

2. Insert the Avid Xpress DV application CD-ROM into the CD-ROM 
drive.

If the installation program doesn't start automatically:

a. Double-click the My Computer icon on your desktop.

b. Double-click the CD-ROM drive icon. 

c. Double-click the Launch icon to start the installer. 

The opening window of the installer opens. 

3. Click Install Avid Xpress DV. 

If you have previously installed Avid Xpress DV, the Setup 
Maintenance program window opens. Follow the steps in “Modifying, 
Repairing, or Removing Avid Applications (Windows)” on page 43.

4. In the Welcome window, click Next.

The Country Selection for License Agreement window opens.

5. Select the country in which you purchased this product. Click Next.

6. In the License Agreement window, read the agreement, and then click 
Yes to accept the terms of the agreement.
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7. In the Choose Destination Location window, accept the default path 
for the application folder (on drive C) by clicking Next. The default 
path is:

C:\Program Files\Avid\Avid Xpress DV

8. In the AVX Plug-in Location window, accept the default path for the 
AVX Plug_in folder (on drive D) by clicking Next. The default path is:

D:\Avid\AVX_Plug-ins

9. In the Application Data Location window, indicate a location for the 
application files (project folders and user folders). The default path is:

C:\Program Files\Avid\Avid Xpress DV

10. Click Next.

11. In the Setup Type window, select an option:

t Select Typical to install all components. This is the recommended 
installation.

t Select Custom to select the components you want to install. See 
“Performing a Custom Installation (Windows)” on page 42.

12. After you have selected an option, click Next.

The installation begins.

When the Avid Xpress DV installation is complete, the Setup 
Complete window opens and asks if you want to restart the system. 

13. Do one of the following:

t Yes, I want to restart my computer now.

t No, I will restart my computer later.

14. Click Finish.
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Performing a Custom Installation (Windows)

You can perform a custom installation to install particular files from the 
installation CD-ROM. Table 3 lists the components available when you use 
the Custom option of the Avid Application Installer.

To perform a custom installation:

1. Follow steps 1 to 9 in the procedure “Installing Avid Xpress DV 
Software and All Components (Windows)” on page 40.

2. In the Setup Type window, click Custom and then click Next.

3. In the Select Components window, click the check boxes next to the 
components you want to install. A check mark indicates the 
component is selected. 

4. After you have selected the components to install, click Next.

n If you have a system (boot) drive that is 2 GB in size, Avid recommends you 
install these files on a drive or partition other than the system drive 
(normally drive C).

5. Click Next. 

The installation begins. When the installation is complete, a message 
asks if you want to restart the system. 

Table 3 Custom Installation Components (Windows)

Component Description

Avid Xpress DV Installs the application and all the necessary 
supporting files, except Help files

Utilities Installs utility files and programs used to support 
the application

Help files Installs the appropriate Help files
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6. Do one of the following:

t Yes, I want to restart my computer now.

t No, I will restart my computer later.

7. Click Finish.

Modifying, Repairing, or Removing Avid Applications (Windows)

If you have installed Avid Xpress DV (or any other Avid application) and 
need to modify, repair, or remove it, you use the Setup Maintenance 
program.

To modify, repair, or remove Avid Xpress DV:

1. Quit all active applications.

2. Insert the Avid Xpress DV application CD-ROM into the CD-ROM 
drive.

If the installation program doesn't start automatically:

a. Double-click the My Computer icon on your desktop.

b. Double-click the CD-ROM drive icon. 

c. Double-click the Launch icon to start the installer. 

The opening window of the installer opens. 

3. Click Install Avid Xpress DV. 

The Welcome window for the Setup Maintenance program opens. It 
presents three options:

t Modify: Select this option to add new program components or 
remove currently installed components. 

n If you select to remove currently installed components, this option does not 
remove registry entries or icons in the Start menu. To fully uninstall 
Avid Xpress DV, select the Remove option.
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n If you want to remove Avid Codec for AVI, RealProducer G2, LSX-MPEG 
(Ligos), ASF NetShow®, or QuickTime®, use the Add/Remove Programs 
dialog box. To access Add/Remove programs, click the Start menu, point to 
Settings, click Control Panel, and double-click the Add/Remove Programs 
icon.

t Repair: Select this option to reinstall the components you 
previously installed.

t Remove: Select this option to completely uninstall all components 
of Avid Xpress DV.

4. Select one of the three options and click Next.

t If you selected Modify, the Select Components window opens. 
Components that are already installed are selected. Select the new 
components you want to install. The installation proceeds, as 
described in steps 12 to 14 in “Installing Avid Xpress DV Software 
and All Components (Windows)” on page 40.

c If you deselect an installed component, the installation program will 
remove the component from the Avid Xpress DV system.

t If you selected Repair, the installation proceeds, as described in 
steps 12 to 14 in “Installing Avid Xpress DV Software and All 
Components (Windows)” on page 40.

t If you selected Remove, a message box asks you to confirm that 
you want to delete the files. Click OK. When the Maintenance 
Complete window opens, click Finish. Click Exit to quit the 
installation program.

If you receive a message about removing shared files, click No.

Installing EDL Manager (Windows)

EDL Manager is an application that allows you to generate EDLs (edit 
decision lists) from sequences exported from any Avid video-based editing 
product. For information on using EDL Manager, see the Avid EDL 
Manager User’s Guide, available on the Avid Xpress DV Online 
Publications CD-ROM. 
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You can install EDL Manager on another computer. For example, you 
might want to install EDL Manager on a portable computer that you can 
take with you to an online suite, or on a computer located at the online 
suite.

To install EDL Manager:

1. Quit all active applications.

2. Insert the Avid Xpress DV application CD-ROM into the CD-ROM 
drive.

3. If the installation program doesn’t start automatically:

a. Double-click the My Computer icon on your desktop.

b. Double-click the CD-ROM drive icon.

c. Double-click the Launch icon to start the installer.

The opening window of the installer opens.

4. Click Install EDL Manager.

If you have previously installed EDL Manager, the Setup Maintenance 
Program window opens. Follow the steps in “Modifying, Repairing, or 
Removing Avid Applications (Windows)” on page 43.

5. In the Welcome window, click Next.

The Country Selection for License Agreement window opens.

6. Select the country in which you purchased this product. Click Next.

7. In the License Agreement window, read the agreement, and then click 
Yes to accept the terms of the agreement.

8. In the Choose Destination Location window, accept the default path 
for the application folder (on drive C) by clicking Next. The default 
path is:

C:\Program Files\Avid\EDL Manager

The installation proceeds and the Install Wizard Complete window 
opens.
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9. Do one of the following:

t Yes, I want to restart my computer now.

t No, I will restart my computer later.

10. Click Finish.

Installing the PowerPack Applications (Windows)

This section describes how to install the Avid Xpress DV PowerPack 
CD-ROM. If you purchased this option, you can install:

• Avid Log Exchange

• Avid FilmScribe™

• Avid IllusionFX™

Installing Avid Log Exchange (Windows)

Avid Log Exchange is an application that allows you to quickly convert 
shot logs created by other sources. You can then import the files directly 
into a bin. For information on using Avid Log Exchange, see the 
Avid Xpress DV User’s Guide. 

To install Avid Log Exchange:

1. Quit all active applications.

2. Insert the Avid Xpress DV PowerPack CD-ROM into the CD-ROM 
drive.

3. If the installation program doesn’t start automatically:

a. Double-click the My Computer icon on your desktop.

b. Double-click the CD-ROM drive icon.

c. Double-click the Launch icon to start the installer.

The opening window of the installer opens.
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4. Click Install Avid Log Exchange.

If you have previously installed Avid Log Exchange, the Setup 
Maintenance Program window opens. Follow the steps in “Modifying, 
Repairing, or Removing Avid Applications (Windows)” on page 43.

5. In the Welcome window, click Next.

The Country Selection for License Agreement window opens.

6. Select the country in which you purchased this product. Click Next.

7. In the License Agreement window, read the agreement, and then click 
Yes to accept the terms of the agreement.

8. In the Choose Destination Location window, accept the default path 
for the application folder (on drive C) by clicking Next. The default 
path is:

C:\Program Files\Avid\Avid Log Exchange

9. In the Application Data Location window, indicate a location for the 
application files (project folders and user folders). The default path is:

C:\Program Files\Avid\Avid Log Exchange

10. In the Setup Type window, select Typical and click Next.

The installation proceeds and the Install Wizard Complete window 
opens.

11. Do one of the following:

t Yes, I want to restart my computer now.

t No, I will restart my computer later.

12. Click Finish.

Installing Avid FilmScribe (Windows)

Avid FilmScribe is an application that allows you to create, modify, and 
manage cut lists and change lists. FilmScribe lists can be used to prepare 
the various postproduction elements of a film project, including work 
prints and final cuts. The FilmScribe application opens bins created on 
Avid editing systems and generates lists from sequences in those bins that 
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contain the appropriate film information. For information on using Avid 
FilmScribe, see the Avid FilmScribe User’s Guide, available on the 
Avid Xpress DV Online Publications CD-ROM. 

To install Avid FilmScribe:

1. Quit all active applications.

2. Insert the Avid Xpress DV PowerPack CD-ROM into the CD-ROM 
drive.

3. If the installation program doesn’t start automatically:

a. Double-click the My Computer icon on your desktop.

b. Double-click the CD-ROM drive icon.

c. Double-click the Launch icon to start the installer.

The opening window of the installer opens.

4. Click Install FilmScribe.

If you have previously installed Avid FilmScribe, the Setup 
Maintenance Program window opens. Follow the steps in “Modifying, 
Repairing, or Removing Avid Applications (Windows)” on page 43.

5. In the Welcome window, click Next.

The Country Selection for License Agreement window opens.

6. Select the country in which you purchased this product. Click Next.

7. In the License Agreement window, read the agreement, and then click 
Yes to accept the terms of the agreement.

8. In the Choose Destination Location window, accept the default path 
for the application folder (on drive C) by clicking Next. The default 
path is:

C:\Program Files\Avid\FilmScribe

9. In the Application Data Location window, indicate a location for the 
application files (project folders and user folders). The default path is:

C:\Program Files\Avid\FilmScribe

10. In the Setup Type window, select Typical and click Next.
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The installation proceeds and the Install Wizard Complete window 
opens.

11. Do one of the following:

t Yes, I want to restart my computer now.

t No, I will restart my computer later.

12. Click Finish.

Installing Avid IllusionFX (Windows)

Avid IllusionFX contains 30 high-quality AVX™ plug-in effects developed 
by Avid. The majority of the effects appear in the IllusionFX category of 
the Effect Palette. For information on using the Avid IllusionFX plug-ins, 
see the Avid IllusionFX Guide on the Avid Xpress DV Online Publications 
CD-ROM. 

To install the Avid IllusionFX Pack:

1. Quit all active applications.

2. Insert the Avid Xpress DV PowerPack CD-ROM into the CD-ROM 
drive.

3. If the installation program doesn’t start automatically:

a. Double-click the My Computer icon on your desktop.

b. Double-click the CD-ROM drive icon.

c. Double-click the Launch icon to start the installer.

The opening window of the installer opens.

4. Click Install IllusionFX Pack.

5. In the Welcome window, click Next.

The installation proceeds and the Install Wizard Complete window 
opens.

Setup has finished installing the Avid IllusionFX Pack.

6. Click Finish.
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Installing the Avid Xpress DV Tutorial Files (Windows)

The Avid Xpress DV Tutorial CD-ROMs contain all the files you need for 
the tutorial chapters of this guide, including DV media that is ready for you 
to use. The tutorial files are shipped on three CD-ROMs, in either NTSC or 
PAL format.

You will need approximately 1 GB of free space available on a media 
drive. It takes approximately 10 minutes to complete the installation 
program.

To install the tutorial files:

1. Quit all active applications.

2. Insert Avid Xpress DV Tutorial CD 1 into the CD-ROM drive.

If the installer doesn't start automatically after you insert the 
application CD-ROM, do the following:

a. Double-click the My Computer icon on your desktop.

b. Double-click the CD-ROM drive icon. 

c. Double-click the Launch icon to start the installer. 

The opening window of the installer opens.

3. Click Install Avid Video Editing Tutorial (NTSC) or Avid Video 
Editing Tutorial (PAL).

4. In the Welcome window, click Next.

5. In the Choose Destination Location window, accept the default path 
and click Next.

This path should add the Avid Projects folder to the path you selected 
for application data when you installed Avid Xpress DV. See 
“Installing Avid Xpress DV Software and All Components 
(Windows)” on page 40. 
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6. In the Select a Drive window, select a drive for the tutorial media and 
click Next.

The installation begins. When the installation is finished with CD 1, a 
message asks you to insert Avid Xpress DV Tutorial CD 2 into the 
CD-ROM drive.

7. Insert Tutorial CD 2 into the CD-ROM drive and click OK. 

n Windows XP has enabled AutoPlay. A Windows type window or an 
AutoPlay window might appear after you insert Tutorial CD 2 or Tutorial 
CD 3. Close this window or Take No Action and continue with the tutorial 
installation.

When the installation is finished with CD 2, a message asks you to 
insert Avid Xpress DV Tutorial CD 3 into the CD-ROM drive.

8. Insert Tutorial CD 3 into the CD-ROM drive and click OK. 

9. When the installation is complete, the Setup Complete window opens. 
Click Finish.

The installation program copies the following folders to your system:

• Saturn project folder: This folder contains the project and bins you 
need for the tutorial and is copied into the Avid Projects folder on your 
hard drive.

• OMFI MediaFiles folder: This folder contains the media files you 
need for the tutorial and is copied to a media drive.
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Installing Avid Xpress DV Software (Macintosh)

This section describes how to install the Avid Xpress DV application and 
its related components from the installation CD-ROM. 

n In order to install or remove the application software, you need to use an 
account with administrative privileges.

Installing Avid Xpress DV Software and All Components 
(Macintosh)

To install the Avid Xpress DV software, you must be logged in with 
administrative privileges. To install the Avid Xpress DV software and all 
related components: 

1. Quit all active applications.

2. Insert the Avid Xpress DV application CD-ROM into the CD-ROM 
drive.

If the installation program doesn't start automatically:

a. Double-click the CD-ROM drive icon on your desktop. 

b. Double-click the Launch icon to start the installer. 

The Authenticate window opens.

3. Enter your Administrator name and password, and then click OK.

The opening window of the installer opens. 

4. In the opening window, click Continue. 

5. With Full Install selected, click Install. 

The Country License List window opens.

6. Select the country in which you purchased this product. Click OK.

7. In the License Agreement window, read the agreement, and then click 
Yes to accept the terms of the agreement.

The installation begins. If you would like to quit the installation at any 
time, click Stop.

8. Click Quit when the Avid Xpress DV installation is complete. 
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Performing a Custom Installation (Macintosh)

You can perform a custom installation to install particular files from the 
installation CD-ROM. Table 4 lists the components available when you use 
the Custom option of the Avid Application Installer.

To perform a custom installation:

1. Follow steps 1 to 3 in the procedure “Installing Avid Xpress DV 
Software and All Components (Macintosh)” on page 52.

2. Choose Custom Install from the menu.

3. Click the check boxes next to the components you want to install. A 
check mark indicates the component is selected. 

4. After you have selected the components to install, click Install.

The Country License List window opens.

5. Select the country in which you purchased this product. Click OK.

6. In the License Agreement window, read the agreement, and then click 
Yes to accept the terms of the agreement.

The installation begins. If you would like to quit the installation at any 
time, click Stop.

7. Click Quit when the installation is complete, or click Continue if you 
would like to install other components.

Table 4 Custom Installation Components (Macintosh)

Component Description

Avid Xpress DV Installs the application and all the necessary 
supporting files, except Help files

Utilities Installs utility files and programs used to support 
the application

Help files Installs the appropriate Help files
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Removing Avid Applications (Macintosh)

If you have installed Avid Xpress DV (or any other Avid application) and 
need to remove it, you use the Setup Maintenance program.

To remove Avid Xpress DV:

1. Quit all active applications.

2. Insert the Avid Xpress DV application CD-ROM into the CD-ROM 
drive.

If the installation program doesn't start automatically:

a. Double-click the CD-ROM drive icon on your desktop.

b. Double-click the Launch icon to start the installer. 

The Authenticate window opens.

3. Enter your Administrator name and password, and then click OK.

The opening window of the installer opens. 

4. In the opening window, click Continue. 

5. Click Uninstall Avid Xpress DV. 

A dialog box appears stating that no other application can be running 
during the operation.

6. Click Continue.

The system removes the Avid Xpress DV application.

7. When the uninstall is successful, click OK.

8. Click Quit to close the installer window.



Installing Avid Xpress DV Software (Macintosh)

55

Installing EDL Manager (for Mac OS X)

EDL Manager is an application that allows you to generate EDLs (edit 
decision lists) from sequences exported from any Avid video-based editing 
product. For information on using EDL Manager, see the Avid EDL 
Manager User’s Guide, available on the Avid Xpress DV Online 
Publications CD-ROM. 

You can install EDL Manager on another computer. For example, you 
might want to install EDL Manager on a portable computer you can take 
with you to an online suite, or on a computer located at the online suite.

To install EDL Manager on Mac OS X:

1. Quit all active applications.

2. Insert the Avid Xpress DV application CD-ROM into the CD-ROM 
drive.

3. If the installation program doesn’t start automatically:

a. Double-click the CD-ROM drive icon on your desktop.

b. Double-click the Launch icon to start the installer.

The Authenticate window opens.

4. Enter your Administrator name and password, and then click OK.

The opening window of the installer opens.

5. In the opening window, click Continue.

6. With Easy Install selected, click Install.

If you have previously installed EDL Manager and want to remove it, 
choose Uninstall. Follow the steps in “Removing Avid Applications 
(Macintosh)” on page 54.

The Country License List window opens.

7. Select the country in which you purchased this product. Click OK.

8. In the License Agreement window, read the agreement, and then click 
Yes to accept the terms of the agreement.
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The installation begins. If you would like to quit the installation at any 
time, click Stop.

9. When the installation is successful a dialog box appears. Click Quit.

Installing EDL Manager (for Macintosh Version 9.2)

To format an RT-11 floppy disk, you need to format the floppy disk using 
Avid EDL Manager running on Macintosh Version 9.2. You can then use 
Avid EDL Manager running on Mac OS X to read and write EDLs to the 
formatted RT-11 floppy disk.

To install EDL Manager on Macintosh Version 9.2:

1. Quit all active applications.

2. Insert the Avid Xpress DV application CD-ROM into the CD-ROM 
drive.

3. If the installation program doesn’t start automatically:

a. Double-click the CD-ROM drive icon on your desktop.

b. Double-click the Launch icon to start the installer.

The opening window of the installer opens.

4. In the opening window, click Continue.

5. With Easy Install selected, click Install.

If you have previously installed EDL Manager and want to remove it, 
choose Uninstall. Follow the steps in “Removing Avid Applications 
(Macintosh)” on page 54.

The Country License List window opens.

6. Select the country in which you purchased this product. Click OK.

7. In the License Agreement window, read the agreement, and then click 
Yes to accept the terms of the agreement.

The installation begins. If you would like to quit the installation at any 
time, click Stop.

8. When the installation is successful a dialog box appears. Click Quit
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Installing the PowerPack Applications (Macintosh)

This section describes how to install the Avid Xpress DV PowerPack 
CD-ROM. If you purchased this option, you can install:

• Avid Log Exchange

• Avid FilmScribe

• Avid IllusionFX

Installing Avid Log Exchange (Macintosh)

Avid Log Exchange is an application that allows you to quickly convert 
shot logs created by other sources. You can then import the files directly 
into a bin. For information on using Avid Log Exchange, see the 
Avid Xpress DV User’s Guide. 

To install Avid Log Exchange:

1. Quit all active applications.

2. Insert the Avid Xpress DV PowerPack CD-ROM into the CD-ROM 
drive.

3. If the installation program doesn’t start automatically:

a. Double-click the CD-ROM drive icon on your desktop.

b. Double-click the Launch icon to start the installer.

The Authenticate window opens.

4. Enter your Administrator name and password, and then click OK.

The opening window of the installer opens.

5. In the opening window, click Continue.

6. With Easy Install selected, click Install.

If you have previously installed Avid Log Exchange and want to 
remove it, choose Uninstall. Follow the steps in “Removing Avid 
Applications (Macintosh)” on page 54.

The Country License List window opens.
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7. Select the country in which you purchased this product. Click OK.

8. In the License Agreement window, read the agreement, and then click 
Yes to accept the terms of the agreement.

The installation begins. If you would like to quit the installation at any 
time, click Stop.

9. When the installation is successful a dialog box appears. Click Quit.

Installing Avid FilmScribe (Macintosh)

Avid FilmScribe is an application that allows you to create, modify, and 
manage cut lists and change lists. FilmScribe lists can be used to prepare 
the various postproduction elements of a film project, including work 
prints and final cuts. The FilmScribe application opens bins created on 
Avid editing systems and generates lists from sequences in those bins that 
contain the appropriate film information. For information on using Avid 
FilmScribe, see the Avid FilmScribe User’s Guide, available on the 
Avid Xpress DV Online Publications CD-ROM. 

To install Avid FilmScribe:

1. Quit all active applications.

2. Insert the Avid Xpress DV PowerPack CD-ROM into the CD-ROM 
drive.

3. If the installation program doesn’t start automatically:

a. Double-click the CD-ROM drive icon on your desktop.

b. Double-click the Launch icon to start the installer.

The Authenticate window opens.

4. Enter your Administrator name and password, and then click OK.

The opening window of the installer opens.

5. In the opening window, click Continue.

6. With Easy Install selected, click Install.

If you have previously installed Avid FilmScribe and want to remove 
it, choose Uninstall. Follow the steps in “Removing Avid Applications 
(Macintosh)” on page 54.
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The Country License List window opens.

7. Select the country in which you purchased this product. Click OK.

8. In the License Agreement window, read the agreement, and then click 
Yes to accept the terms of the agreement.

The installation begins. If you would like to quit the installation at any 
time, click Stop.

9. When the installation is successful a dialog box appears. Click Quit.

Installing Avid IllusionFX (Macintosh)

Avid IllusionFX contains 30 high-quality AVX plug-in effects developed 
by Avid. The majority of the effects appear in the IllusionFX category of 
the Effect Palette. For information on using the Avid IllusionFX plug-ins, 
see the Avid IllusionFX Guide on the Avid Xpress DV Online Publications 
CD-ROM. 

To install the Avid IllusionFX Pack:

1. Quit all active applications.

2. Insert the Avid Xpress DV PowerPack CD-ROM into the CD-ROM 
drive.

3. If the installation program doesn’t start automatically:

a. Double-click the CD-ROM drive icon on your desktop.

b. Double-click the Launch icon to start the installer.

The Authenticate window opens.

4. Enter your Administrator name and password, and then click OK.

The opening window of the installer opens.

5. In the opening window, click Install.

6. If the Select Folder dialog box appears. Select the Avid application 
folder and click OK.

The installation begins. If you would like to quit the installation at any 
time, click Stop.

7. When setup has finished installing the Avid IllusionFX Pack, click 
Quit.
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Installing the Avid Xpress DV Tutorial Files 
(Macintosh)

The Avid Xpress DV Tutorial CD-ROMs contain all the files you need for 
the tutorial chapters of this guide, including DV media that is ready for you 
to use. The tutorial files are shipped on two CD-ROMs, in either NTSC or 
PAL format.

You will need approximately 1 GB of free space available on a media 
drive. It takes approximately 10 minutes to complete the installation 
program.

n You must have an OMFI MediaFiles folder created on your Macintosh HD 
before installing this tutorial.

To install the tutorial files:

1. Quit all active applications.

2. Insert Avid Xpress DV Tutorial CD 1 into the CD-ROM drive.

3. Double-click the DV Tutorial (NTSC or PAL) CD-ROM icon on your 
desktop. 

4. Double-click the DV Tutorial (NTSC or PAL) Installer icon to start the 
installer. 

The opening window of the installer opens.

5. With Easy Install selected, click the Install button.

If you have more than one Avid Projects folder created on your system, 
a Select Folder dialog box appears asking you to select the Avid 
Projects folder where you want to install the tutorial project. Click OK.

The installation begins. If you don’t have an OMFI MediaFiles folder 
created on your Macintosh HD, a message appears. When the 
installation is finished with CD 1, a message asks you to insert 
Avid Xpress DV Tutorial CD 2 into the CD-ROM drive.

6. Insert Tutorial CD 2 into the CD-ROM drive and click OK. 

7. When the installation is complete, click Quit.
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The installation program copies the following folders to your system:

• Saturn project folder: This folder contains the project and bins you 
need for the tutorial and is copied into the Avid Projects folder on your 
hard drive.

• OMFI MediaFiles folder: This folder contains the media files you 
need for the tutorial and is copied to a media drive.

Creating an Emergency Repair Floppy Disk (Windows 
Only)

Whenever you add new software or change your disk configuration, you 
should create a new emergency repair floppy disk.

To create an emergency repair floppy disk:

1.  Start your system and log in to an account with administrative 
privileges. 

2.  Click the Start button, point to Programs, point to Accessories, point 
to System Tools, and select Backup. 

The Backup window opens.

3.  Click the Emergency Repair Disk icon.

A dialog box appears.

4. Select the “Also backup the registry to the repair directory” option. 

5. Insert a blank, formatted floppy disk into drive A. 

6. Click OK.

7. Label the emergency repair floppy disk, date it, and store it in a safe, 
dry, static-free location.
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Connecting the Editing Equipment

Make sure you have completed the setup information provided with your 
computer. This information provides instructions for setting up your 
computer and attaching the monitor, keyboard, and mouse. The 
documentation that comes with your equipment explains the locations of 
cable connections and how to connect the cables. 

n The term FireWire, IEEE 1394, and i.LINK are considered to be the same 
thing. In this document the term 1394 is used. 

This section explains the connections between the editing equipment and 
the computer in general terms because you might be connecting your 
editing equipment to:

• A supported desktop or laptop system running the Windows XP 
Professional operating system

• A supported Macintosh system running the Mac OS X operating 
system

Your editing equipment might be a digital camera, a digital video deck, or 
an analog video deck connected to a transcoder. 

n The cameras, video decks, and transcoders in the illustrations represent 
the type of equipment explained in the text. The actual equipment you have 
might be different. 
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This section contains the following topics:

• 1394 Cable Connectors

• Connecting a 1394 Cable

• Connecting a Computer Without a Client Monitor

• Connecting a Client Monitor Overview

• Connecting a Client Monitor over a 1394 Port

• Audio and Video Sync Issues

• Connecting a Client Monitor to an Analog Port

• Controlling an Analog Video Deck (Windows)

• Controlling an Analog Video Deck (Macintosh)

• Connecting a VTR Emulator (Windows Only)

1394 Cable Connectors

The connections on your computer system and your editing equipment 
(such as a digital camera, digital video deck, or transcoder used with an 
analog video deck) have either four pins or six pins. Therefore, the 1394 
cables used to connect this equipment need either 4-pin or 6-pin 
connectors (see Figure 6).

Figure 6 1394 Connectors

4-pin 6-pin
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Connecting a 1394 Cable

You use a 1394 cable to connect a digital video deck, a digital camera, or a 
transcoder (connected to an analog video deck) to a PCI or PCMCIA 
capture board in your computer, or directly to a 1394 port at the rear of a 
Macintosh system (see Figure 7).

Figure 7 Connecting a 1394 Cable

A 1394 cable is normally referred to by the number of pins in the 
connector at each end of the cable (see “1394 Cable Connectors” on 
page 63). There are normally three types of 1394 cables:

• 4-pin to 4-pin 

• 4-pin to 6-pin 

• 6-pin to 6-pin 
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Before connecting a 1394 cable, you must determine the type of 1394 
cable you need. For example, you might need to connect a digital camera 
that has a 4-pin connection to a Macintosh system that has a 6-pin 
connection. In this case you would need the 4-pin to 6-pin cable (see 
Figure 8).

Figure 8 4-Pin to 6-Pin Connection

When you purchase a PCI board or PCMCIA board, you usually receive at 
least one type of 1394 cable. You might have to purchase an additional 
1394 cable to match your needs, depending on the equipment you 
purchased. The documentation that comes with your equipment explains 
the locations of cable connections and how to actually connect the cables. 
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Connecting a Computer Without a Client Monitor 

To connect equipment without a Client monitor to your computer:

1. Connect the monitor, speakers, keyboard, and mouse to the rear of 
your computer using the documents that came with your desktop 
computer. If you have a laptop, connect only needed components.

2. Connect the 1394 cable from a digital video deck, a digital camera, or 
a transcoder (connected to an analog video deck) to a PCI or PCMCIA 
capture board in your computer, or to the rear of a supported 
Macintosh system (as explained in the documentation that comes with 
your equipment). Figure 9 shows an example of a digital video deck 
connected to a PCI capture board.

The computer uses the same 1394 cable to input and output data to and 
from a digital video deck, a digital camera, or a transcoder (connected 
to an analog video deck). The output data can be recorded or used to 
control a digital video deck or digital camera.

n The output data can be sent through a transcoder to be recorded on an 
analog video deck, but control of the analog video deck must be done 
remotely using the serial port (see “Controlling an Analog Video Deck 
(Windows)” on page 73).

3. Turn on power to all peripheral equipment and then the system.

Figure 9 Connecting a Computer Without a Client Monitor
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Connecting a Client Monitor Overview

To fully understand how a Client monitor receives data from an 
Avid Xpress DV system, it is helpful to understand how Timeline 
information is processed and sent to the Composer monitor from the 
computer system (see Figure 10).

• You turn real-time effects on or off by clicking the Real-Time Effects 
button in the Timeline. The real-time effects are off when the button is 
green, and on when the button is blue.

• When real-time effects are off, the desktop display shows a sequence 
displayed with a full-resolution signal without the digital effects.

• When real-time effects are on, the desktop display shows a sequence 
displayed with a slightly lower-resolution signal generated because it 
includes the digital effects. 

n Having real-time effects on or off should not cause a difference in the 
display as long as you have High Quality selected in the Display Settings 
of your project. You might see a difference in the display if you have High 
Performance selected in the Display Settings of your project.

Figure 10 Displaying Timeline Information
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When you turn real-time effects on or off you also determine the path of 
the signal to Client monitors from the computer system (see Figure 11). 

• If you have real-time effects off, the desktop display shows a sequence 
displayed with a full-resolution signal without the digital effects. The 
signal is sent out the 1394 port connection to the Client monitor 
attached to a digital video deck or to the digital camera acting as a 
Client monitor.

• If you have real-time effects on, the desktop display shows a sequence 
displayed with a slightly lower-resolution signal generated because it 
includes the digital effects. The signal is sent out an analog connection 
(S-Video or VGA) to a Client monitor with a resolution of 800 x 600. 

Figure 11 Client Monitor Overview
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Connecting a Client Monitor over a 1394 Port

To connect a Client monitor to a Windows or Macintosh system (a 
Windows system is shown as an example):

1. Connect the system as you did in “Connecting a Computer Without a 
Client Monitor” on page 66, but don’t turn on the power.

2. Connect a Client monitor to a digital video deck, a digital camera, or a 
transcoder using the necessary analog cable. Figure 12 shows an 
example of a digital video deck connected to a Client monitor.

3. Connect powered external speakers (or built-in speakers) to a digital 
video deck, a digital camera, or a transcoder using the necessary 
cables. 

4. Turn on the power to all peripheral equipment and then the system.

5. When you run Avid Xpress DV, you must turn real-time effects off to 
enable the output data to be sent to the 1394 port. 

n The output video and audio are synchronized as client audio and video, 
and do not match the video displayed on the computer monitor and the 
audio sent to the system speakers (see “Audio and Video Sync Issues” on 
page 70).

Figure 12 Connecting a Computer with a Client Monitor
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Audio and Video Sync Issues

With the Avid Xpress DV system set up as shown in Figure 13, the video 
and audio might appear to be out of sync in the following situations:

• You are recording from a digital device 

• A Client monitor is attached

The system, however, is functioning normally, as explained in the 
following sections:

• Sync Issue: When recording from a digital device (a digital camera, 
digital video deck, or transcoder), what you see on the Composer 
monitor and hear from the system speakers is not in sync with the 
incoming video and audio coming from the digital device. 

Explanation: The incoming video and audio from the digital device 
must be buffered, and then fed to the Composer monitor and system 
speakers. Although it might look and sound out of sync from the 
digital device output, the video and audio is being recorded properly. 
For example, if you are marking IN and OUT points while previewing 
video, the points will be placed in the correct location for editing.

Figure 13 Avid Xpress DV System with Client Monitor
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• Sync Issue: With a Client monitor attached, the audio you hear from 
the system speakers is not in sync with the video on the Client monitor. 

Explanation: Avid Xpress DV processes the video and audio and 
sends it to the Composer monitor and system speakers. The Composer 
video and audio will always be in sync.

However, Avid Xpress DV also provides the same video and audio in 
1394 format to a digital device (digital camera, digital video deck, or 
transcoder) connected by a 1394 cable (see Figure 13). 

Because the Client monitor is attached to the digital device, the delay 
between the time the video and audio is processed internally and sent 
to the digital device causes the video on the Client monitor to be out of 
sync with the audio from the system speakers.

If you need to use a Client monitor for video and hear synchronized 
audio:

- Attach a separate pair of speakers to the same digital device the 
Client monitor is attached to.

- Turn off or disconnect the system speakers.

Client monitor video and audio from external speakers are always in 
sync when they are sent to the digital device.
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Connecting a Client Monitor to an Analog Port

When you run Avid Xpress DV you must turn real-time effects on to 
enable the output data to be sent to the Client monitor attached to the 
analog port (see “Connecting a Client Monitor Overview” on page 67).

Analog Connection on a Windows System

You can connect a Client monitor directly to the second VGA port of the 
Matrox® 550 graphics card on a Windows system. 

Analog Connection on a Macintosh System

You can connect a Client monitor directly to the analog ports of the 
following two supported Macintosh products (for supported Macintosh 
products see the Avid Knowledge Center): 

• PowerBook® G4 (Titanium) with rear S-Video output

• Power Macintosh® G4 using a digital-to-VGA adapter on the digital 
output of the Apple® graphics board

n You cannot connect a Client monitor to the rear of an iMac® system. The 
VGA connectors at the rear only mirror the iMac system’s built-in display.

Analog Connection Requirements

The following conditions must be met before the connected monitors can 
receive data as a Client monitor:

• Real-time effects must be enabled 

• The console must have a resolution of 800 x 600

n You can also connect a Client monitor to a digital video deck or a digital 
camera as explained in “Connecting a Client Monitor over a 1394 Port” 
on page 69.
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Controlling an Analog Video Deck (Windows)

Your Avid Xpress DV software provides analog video deck control using 
the serial port on your Windows system. The serial port connects to a 
remote serial control connector, which is available on most analog video 
decks. 

To control the analog video deck, you need an optional RS-232 to RS-422 
serial cable or an adapter kit. Although an adapter kit must be purchased 
separately, the following procedure explains how to connect a sample 
adapter kit between your Windows system and an analog video deck using 
the following:

• An RS-232 to RS-422 serial adapter

• Two serial cables with 9-pin male connectors at both ends

To connect a single deck to your computer:

1. Purchase an adapter kit.

2. Attach one end of the first 9-pin cable to the end of the serial adapter 
labeled RS-232 (see Figure 14). 

3. Attach the other end of the first 9-pin cable to the serial port of the 
computer.

Figure 14 Analog Video Deck Control Cabling (Windows)
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Controlling an Analog Video Deck (Macintosh)

If your supported Macintosh system has a USB port, you can control an 
analog video deck. Your Avid Xpress DV software provides analog video 
deck control using the USB-to-serial adapter (connected to the USB port 
on your Macintosh system) and an RS-232 to RS-422 serial adapter kit. 
The RS-422 serial port of the adapter kit connects to a remote serial control 
connector, which is available on most analog video decks. 

Although the USB-to-serial adapter and RS-232 to RS-422 serial adapter 
kit must be purchased separately, the following procedure explains how to 
connect a sample adapter kit between your system and an analog video 
deck using the following:

• The USB-to-serial adapter (Avid supports only the Keyspan Twin 
Serial Adapter, Keyspan part number USA-28x) 

• An RS-232 to RS-422 serial adapter

• Two serial cables with 9-pin male connectors at both ends

To connect a single deck to your computer:

1. Purchase the Keyspan Twin Serial Adapter (USA-28x), an RS-232 to 
RS-422 serial adapter, and two serial cables.

2. Plug the USB connector of the Keyspan Twin Serial Adapter into a 
USB port on the Macintosh system (see your system documentation 
for the USB port location).

3. Install the Keyspan Twin Serial Adapter software using the 
instructions located on the Keyspan Twin Serial Adapter CD-ROM. 
You might have to go to the Keyspan Web site and download the 
software if you don’t have the CD-ROM.

4. Attach one end of the first 9-pin cable to the end of the serial adapter 
labeled RS-232 (see Figure 15). 

5. Attach the other end of the first 9-pin cable to serial port 1 of the 
Keyspan Twin Serial Adapter.
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Figure 15 Analog Video Deck Control Cabling (Macintosh)

6. Attach one end of the second 9-pin cable to the end of the serial 
adapter labeled RS-422. 

7. Attach the other end of the second 9-pin cable to the remote serial port 
of the analog video deck.

n You will need to configure the analog video deck in the Avid Xpress DV 
Deck Configuration settings of your project. See the user’s guide for more 
information.

Connecting a VTR Emulator (Windows Only)

Avid supports the connection of a VTR emulator to the system. You need 
the following equipment to connect the emulator to the system:

• A serial adapter kit that contains:

- A serial adapter

- Two serial cables; one male-to-male 9-pin connector and one 
male-to-female 9-pin connector

• A VTR emulator cable; male-to-female 9-pin connector

To connect the VTR emulator to the system:

1. Locate the three cables.

2. Attach the male end of the male-to-female 9-pin serial cable to the 
serial adapter labeled RS-232.

to USB port
Serial adapter RS-232 connectionRS-422 connection

To analog
video deck

USB-to-serial
adapter

Keyspan

To USB-to-serial 
adapter

USB connector

port 1
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3. Attach the female end of the male-to-female 9-pin serial cable to the 
serial port of the PC (see Figure 16).

Figure 16 Connecting a VTR Emulator

4. Attach the male end of the VTR emulator cable to the serial adapter 
labeled RS-422.

5. Attach the female end of the VTR emulator cable to the male end of 
the male-to-male 9-pin serial cable.

6. Attach the other end of the male-to-male 9-pin serial cable to the VTR 
emulator. 

Serial cable
to VTR emulator

VTR emulator cable
RS-232 sideRS-422 side

Serial cable
to PC serial port

Serial adapter
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Assigning a Driver to Your Digital Device (Windows 
Only)

To record (input) digital data from your supported digital device, you must 
connect the digital device to the 1394 board (see “Connecting a 1394 
Cable” on page 64). You then need to assign a driver to the digital device.

Avid provides a driver (CustomDV.sys) that you must assign to each digital 
device you connect to the 1394 board. This driver allows the Avid software 
to control the digital device connected to the 1394 board. If you connect 
different digital devices to the 1394 board, you need to assign the same 
CustomDV.sys driver to each digital device. 

n You should not connect a digital device to the 1394 board until you have 
installed the Avid software. The Avid software installs the OHCI-compliant 
driver (CustomDV.sys) you assign to each digital device you connect to the 
1394 board.

The following is a general explanation of what occurs when you physically 
connect a digital device to the 1394 board and apply power to the digital 
device:

• The digital device generates a signal to the Windows operating system 
notifying the operating system that a digital device is now attached to 
the system. 

• The operating system polls the digital device connected to the 1394 
board to determine what type of digital device is connected.

• The operating system checks to see if that digital device has an 
assigned driver. 

- If the digital device has been previously connected to the 1394 
board, you should already have assigned a driver to the digital 
device and nothing is done. 

- If the digital device has not been previously connected to the 1394 
board and does not have a driver assigned, the Windows operating 
system opens the Found New Hardware Wizard to assign a driver 
to the digital device.
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To assign the CustomDV.sys driver to the 1394 DV Camcorder (Non 
DirectShow) digital device using the Found New Hardware Wizard:

1. Connect the digital device to the 1394 board and apply power to the 
digital device. The Found New Hardware Wizard appears (see 
Figure 17).

Figure 17 Found New Hardware Wizard

2. Click Next. The Found New Hardware Wizard continues to prompt for 
the needed information.

3. Select “Search for a suitable driver for the 1394 DV Camcorder (Non 
DirectShow)” and click Next. The Found New Hardware Wizard 
continues to prompt for the needed information.

4. Select “Specify location” and click Next. 

The Found New Hardware Wizard dialog box appears (see Figure 18).

Figure 18 Found New Hardware Wizard Dialog Box
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The system is normally 
drive C.

5. Type System drive:\WINNT\INF as the location to get the 
manufacturer’s file. Click Browse.

A Locate File dialog box appears.

6. Select CustomDV.inf and click Open.

n CustomDV.inf is an installation information file used by the Found New 
Hardware Wizard to install the CustomDV.sys driver. If you do not see 
the.inf file, you might need to enable the View options to show hidden files. 

To enable show hidden files:

a. Double-click the My Computer icon on your desktop.

b. Choose Folder Options from the Tool menu.

c. Click the View tab.

d. Select the Show hidden files and folders option.

e. Click OK.

You should now be able to select CustomDV.inf and click Open.

7. Click OK in the Found New Hardware Wizard. 

The Found New Hardware Wizard continues and shows the results of 
the driver search:

- The 1394 DV Camcorder (Non DirectShow) digital device

- The system drive:\WINNT\INF\CustomDV.inf

8. Click Next. 

A Digital Signature Not Found dialog box appears.

9. Click Yes. An Insert Disk dialog box appears. 
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10. Click OK. A Files Needed dialog box appears (see Figure 19).

Figure 19 Files Needed Dialog Box

The system is normally 
drive C.

11. Type System Drive:\WINNT\SYSTEM32\DRIVERS 
in the “Copy files from” text box and click OK.

12. Click Finish. Your digital device, 1394 DV Camcorder (Non 
DirectShow), has now been assigned the CustomDV.sys driver.

To see if the CustomDV.sys driver has been properly installed:

1. Leave the digital device connected to the 1394 board, but turn off the 
power to the digital device.

2. Click the Start button, point to Settings, and then select Control Panel.

3. Double-click the System icon.

4. Click the Hardware tab.

5. Click Device Manager.

6. Click the + sign of Sound, Video, and Game Controller.

7. Turn on the power to the digital device. 

In a few seconds you should see “1394 DV Camcorder (Non 
DirectShow)” appear in the Sound, Video, and Game Controller 
section.
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Turning Off Your Equipment (Windows)

When you are finished using your system and want to turn it off 
completely, follow these steps to avoid damaging your computer or media 
storage drives. Make sure to quit Avid Xpress DV before turning off your 
equipment. 

To turn off your equipment:

1. Choose Shut Down from the Start menu. The Shut Down Windows 
dialog box appears.

2. Select the “Shut down” option from the list box and click OK.

3. When the system displays a message telling you it is safe to turn off 
your computer, press the Power button on the computer.

4. Turn off your speakers and monitors.

5. Turn off each external media drive.

6. Turn off all other hardware.

c Never remove external media drives from your Avid Xpress DV system 
when it is turned on. Shut down the computer and drives before you 
move drives.
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Turning Off Your Equipment (Macintosh)

When you are finished using your system and want to turn it off 
completely, follow these steps to avoid damaging your computer or media 
storage drives. Make sure to quit Avid Xpress DV before turning off your 
equipment. 

To turn off your equipment:

1. Choose Shut Down from the Apple menu. 

2. Turn off your speakers and monitors.

3. Turn off each external media drive.

4. Turn off all other hardware.

c Never remove external media drives from your Avid Xpress DV system 
when it is turned on. Shut down the computer and drives before you 
move drives.



Chapter 3

About Avid Xpress DV

This chapter explains the basic concepts and terminology that you need to 
be familiar with to edit video with Avid Xpress DV. This chapter contains 
the following sections:

• About DV

• Nonlinear Editing with Avid Xpress DV

• Avid Xpress DV Terms and Concepts

• The Avid Xpress DV File System

• Project Workflow

About DV

The initials DV in the product name Avid Xpress DV stand for digital 
video. More specifically, they refer to digital video that is transferred 
through equipment conforming to IEEE Standard 1394. This equipment 
(cameras, video and audio decks, cables, connectors, and processing 
boards) is sometimes referred to as FireWire or i.LINK. DV connections let 
you transfer digital data (both video and audio) directly from a DV camera 
to a digital, nonlinear editing system with no conversion losses. DV 
technology simplifies the process of bringing footage from your camera 
into your Avid Xpress DV system, and gives you high-quality video at low 
cost.
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Nonlinear Editing with Avid Xpress DV

In traditional video editing, you electronically copy (dub) video and audio 
footage from a source tape to a master tape. This process is tedious, 
however, and it is difficult to make changes to your work. 

By contrast, when you edit with Avid Xpress DV, you don’t have to dub 
footage onto a master tape. Instead, you manipulate Avid Xpress DV clips, 
which are segments of the media that contain pointers to your digital audio 
and video files. Avid Xpress DV allows you to experiment with every edit 
you make. You can trim, move, delete, duplicate, or modify individual 
frames or entire segments, and immediately see the results. This type of 
editing is called nonlinear because you are not limited by the traditional 
video editing need to dub one clip after another.

Avid Xpress DV Terms and Concepts

This section explains the following terms and concepts to help you 
understand the Avid Xpress DV editing process:

• Media Files

• Clips

• Subclips

• Sequences

• Bins

• Projects

• The Attic Folder

Media Files

Media files store source 
material.

When you record source material from a camera or deck, or when you 
import computer graphic files into your Avid Xpress DV project, the 
material is saved in media files on your system’s media drive or drives. One 
media file is created for each track of video or audio. For a video with a 
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stereo sound track, three media files are created: one track of video and 
two tracks of audio. Media files are stored in the OMFI MediaFiles folder 
and each media drive has its own OMFI MediaFiles folder.

n Even though your media files contain the actual source material for the 
program, you never manipulate the media files directly. Instead, you move, 
copy, and edit clips, subclips, and sequences, which are pointers to the 
media files.

Clips

Clips point to media 
files.

When you record media, Avid Xpress DV creates a master clip on your 
system’s internal hard drive (Windows) or Macintosh HD (Macintosh). 
The master clip is simply a pointer to its corresponding media file, which is 
located in the OMFI MediaFiles folder on a media drive. A media drive 
can be inside the computer (an internal media drive) or outside the 
computer (an external media drive).

While editing your video, you create other clips, such as graphic clips and 
effects clips. You make your edits by modifying clips, and the 
corresponding media files remain unchanged. This feature allows you to 
easily create and undo edits without destroying your original material.

Video deck

Master clip

Media drive

OMFI
MediaFiles
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Because you work with clips instead of media files, you can create 
virtually unlimited versions of a program without creating multiple copies 
of the source material, which is stored in extremely large files.

Subclips

Subclips are sections 
that you mark within 
clips.

Subclips are sections of clips that you want to use in your sequence. You 
create a subclip by marking IN (start) and OUT (end) points in a clip, 
pressing and holding the Alt key (Windows) or Option key (Macintosh), 
and dragging the clip to the bin. The subclip is composed of the material 
between the IN and OUT points.

c A subclip points to a media file’s master clip. You must not delete the 
master clip from which a subclip was created. If you delete the master 
clip, you will lose the information in the subclip.

Sequences

A sequence is a
program created from 
one or more clips and 
subclips.

You can join different clips and subclips to create a sequence. A sequence 
can include edited material from master clips and subclips, new clips 
created when you add effects during the editing process, and material from 
other sequences. 

Master

Subclip  
clip
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A sequence is composed of marked material from clips, subclips, and other 
sequences. The material outside the IN and OUT points remains in the 
media file’s master clip. These segments of material are called handles. 
Handles are important; you need them to trim cuts and create transition 
effects between segments. For more information about trimming cuts, see 
“Dual-Roller Trimming” on page 157. For more information about 
transition effects, see “Adding a Dissolve Effect (Fade In)” on page 163.

Like clips and subclips, a sequence contains pointers to media files, which 
are stored in the OMFI MediaFiles folder. If you delete a clip used to create 
a sequence, the sequence still displays the media, because the sequence 
contains its own pointers to the media files.

Sequence

Subclip

Master clip

Sequence

Handle

IN point OUT point

Handle

Sequence

Clip

Subclip
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Bins

You organize your 
footage in bins.

Clips, subclips, and sequences are organized and stored in bins. 
Traditionally, a bin is a place where film editors store reels of film. In 
Avid Xpress DV, bins represent a database for organizing the material for a 
project.

Projects

A project consists of 
one or more bins.You 
edit sequences within a 
project. 

You gather the material you need to create a program in a project. Each 
project contains information about bins, clips, subclips, sequences, and the 
program in the Timeline. You might have several projects on your system, 
but you can work on only one project at a time.

The Attic Folder

For a complete 
description of 
retrieving bins from the 
Attic folder, see the 
Avid Xpress DV User’s 
Guide or Help.

Avid Xpress DV saves copies of your current project and its bins at regular 
intervals and whenever you save or close a project or bin. These auto-save 
files are stored in the Attic folder at the top level of the internal hard drive 
(Windows) or Macintosh HD (Macintosh). If you lose work due to a power 
outage or system error, open the Attic folder and look for a project or bin 
of the same name with the file name extension.bakxx, where xx is the 
version number. For example, the first backup file for the Saturn Bin would 
be named Saturn Bin.bak01. Later versions would be named Saturn 
Bin.bak02, Saturn Bin.bak03, and so on.

The Avid Xpress DV File System

The following illustration shows the different kinds of Avid Xpress DV 
files and where they are stored. The Avid Xpress DV application folder is 
stored on your computer’s internal hard drive (Windows) or Macintosh HD 
(Macintosh). The Avid Projects folder is also stored on an internal drive; 
the location varies, depending on your installation. An OMFI MediaFiles 
folder is stored on each media drive. Media files must be stored on a 
separate, Avid-approved media drive that is guaranteed to be fast enough to 
support video playback.
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For complete 
information about 
folders and files, see 
the Avid Xpress DV 
User’s Guide or Help.

Project Workflow

The following sections illustrate the four stages of a typical 
Avid Xpress DV project: starting a project, preparing to edit, editing a 
sequence, and generating output.

Complete procedures for each stage are included in the printed manuals, 
online books, and Help.

Media drive

Avid Avid

Project

Project

Bin A Bin B
Supporting

Avid Xpress DVSettings

Help

OMFI
MediaFiles

 ProjectsXpress DV

files
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Starting a Project

1. Turn on your 
equipment in the 
correct order and start 
the software. (Speakers 
and external media 
drives are optional.)

2. Select or create a 
new project: the job 
that will result in one 
or more finished 
sequences.

3. Create and organize 
bins.

4. Back up your project 
on a regular basis.

Starting a project involves the following steps:

2. Select or create a project.

3. Create and organize bins.

4. Back up the project.

1. Turn on and start your Avid system.
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Preparing to Edit

1. (Optional) Import 
your log files into the 
bins, or log the material 
manually.

2. Record your DV 
footage, creating media 
files and master clips.

3. Work with bins and 
clips to organize your 
source material for easy 
access during editing.

4. (Optional) Build a 
storyboard to begin 
previsualizing your 
final cut before editing.

Preparing to edit involves the following steps:

3. Sort and organize clips in the bins.

4. Previsualize with storyboards.

2. Record footage, creating
master clips and media files.

1. (Option) Import shot logs into the bin.
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Editing a Sequence

1. View your clips in 
advance and mark IN 
points and OUT points, 
or create subclips based 
on selected portions of 
your master clips.

2. Build your sequence 
using editing controls 
with the Timeline, 
Source pop-up 
monitors, and the 
Composer monitor.

3. Fine-tune your edits 
and effects using 
functions of the various 
edit modes, such as 
Segment mode, Trim 
mode, and Effect mode.

4. Adjust and mix 
multiple audio tracks 
and prepare for final 
playback or output, 
using the Audio tool 
and Audio Mix tool.

5. Return to editing if 
further adjustments are 
required.

Editing a sequence involves the following steps:

Composer
monitor

Source
pop-up

Timeline

2. Edit with Timeline and monitors.

3. Fine-tune edits and effects.

4. Fine-tune audio pan, volume, and EQ.

5. Screen and 1. Screen, mark, and subcatalog footage.
continue editing
as necessary.

monitor
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Generating Output

Export material for 
audio sweetening or 
graphics enhancement 
in a third-party 
application, for 
incorporating into a 
multimedia project, or 
for publishing on the 
Internet.

Record the final 
sequence to tape 
as a digital cut.

Generate an EDL for 
online videotape 
editing.

Generating various forms of output based on your sequence involves 
selecting among several options: 

Export material for additional processing,
for incorporating into a multimedia project,

Record a digital cut directly to tape.

Generate an EDL for online
videotape editing.

or for publishing on the Internet.

DV
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Chapter 4

Learning How to Use 
Avid Xpress DV

This chapter explains the different resources that can help you learn how to 
use your Avid Xpress DV system. This chapter contains the following 
sections:

• Using the Tutorial

• Using Help

• Using Online Documentation

• Tips and Other Resources

Using the Tutorial

The self-paced tutorial chapters in this guide are designed as guided Avid 
editing sessions, using the basic features of the Avid system. In this 
tutorial, you’re going to edit a 1-minute sequence. You can publish the 
sequence on tape, DVD, CD-ROM, or stream it across the Internet.
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The footage for the sequence is supplied on the Avid Xpress DV Tutorial 
CD-ROMs that came with your system. This footage is DV media that has 
already been recorded and is ready for you to use. Footage is supplied in 
either NTSC or PAL format, which is indicated on the CD-ROMs. 

This tutorial does not cover the process of recording video and audio from 
a camera or video deck. You can find instructions for recording in the 
Avid Xpress DV User’s Guide and Help.

Before you begin, make sure you have installed the tutorial media and 
project files (see “Installing the Avid Xpress DV Tutorial Files (Windows)” 
on page 50 and “Installing the Avid Xpress DV Tutorial Files (Macintosh)” 
on page 60).

Depending on your level of expertise in editing on Avid systems, you can 
select to work through the tutorial in either of two ways.

t If you have no experience with Avid Xpress DV or other Avid systems, 
you should go through the entire tutorial. 

t If you have used other Avid systems, you might want to read certain 
chapters to understand the specific features of Avid Xpress DV and 
complete the tutorial tasks in that chapter. For most chapters, you can 
load a sequence that includes the work done up to that point.

Completing the entire tutorial can take from 3 to 4 hours. 

Using Help

You can get help and background information for tasks, windows, dialog 
boxes, and screen objects through your Avid Help system. Your Help 
system is HTML-based and operates in a Web browser. You need 
Version 4.5 or later of Microsoft® Internet Explorer.

Setting Up Your Browser

You must have cookies enabled in your browser to use several capabilities 
of your Avid Help system. Avid does not retain personal information about 
you or your system other than your frequently visited Help topics.
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To enable cookies:

1. Choose Internet Options from the Internet Explorer Tools menu.

2. Click the Privacy tab.

3. Click the slider and drag it toward the bottom to Accept All Cookies.

4. Click Apply, and then click OK.

Getting Help for Windows and Dialog Boxes

The Help system provides you with context-sensitive Help for windows 
and dialog boxes, such as tools and settings. 

To get Help for windows and dialog boxes:

1. Make sure the Avid application is active.

2. Position the mouse pointer anywhere in the window or dialog box for 
which you want help.

3. Press the F1 key (Windows) or Help key (Macintosh) on the keyboard.

If there is no information about a window or dialog box, a Navigation 
Canceled message appears in the browser. Open Help and use the 
Search or Index functions to look for information on that window or 
dialog box.

Getting Help for Screen Objects

You can use What’s This? Help to find out about buttons and other screen 
objects.

To get Help for screen objects:

1. Do one of the following:

t (Windows) Using the right mouse button, click the screen object 
(for example, a button).

t (Macintosh) Ctrl+Shift+click the screen object (for example, a 
button).

A pop-up menu appears.
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2. Choose What’s This? from the pop-up menu.

A browser window opens that explains how you use the item. Many 
windows include a link (marked by underlined text) to more 
information.

n (Windows only) For some dialog boxes, such as Import and Print, use the 
Question Mark button to access What’s This? Help.

Keeping Help Available (Windows Only)

When you access a Help topic and then return to the Avid application, the 
Help browser disappears behind the Avid system.

To keep Help available, you can use one of the methods in the following 
topics:

• Restoring Help from the Taskbar (Windows Only)

• Resizing the Application (Windows Only)

• Using Alt+Tab to Restore Help (Windows Only)

Restoring Help from the Taskbar (Windows Only)

You can restore Help from the taskbar at the bottom of the screen. All your 
active applications are represented by buttons on the taskbar.

To restore Help, click the browser button on the taskbar, and Help 
reappears.

n If you can’t see the taskbar, you might have set a property that hides it.

To keep the taskbar on top:

1. Right-click in an area of the taskbar where there are no buttons.

2. Choose Properties from the pop-up menu.

The Taskbar Properties dialog box appears.

3. Select Always on top.
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4. Deselect Auto hide.

5. Click OK.

The taskbar remains visible at all times.

n If you want the taskbar to appear only when you pass the pointer over the 
bottom of the screen, select Auto hide along with Always on top.

Resizing the Application (Windows Only)

To resize the application and leave Help available:

1. With Help active, click the purple Help title bar and drag it to the top of 
the screen. 

2. Click in the Avid application.

The Help browser disappears behind the Avid system.

3. Click the Restore button in the top right corner of the application.

The application shrinks slightly and reveals the Help browser behind it.

This allows you to click back and forth between the application and the 
Help browser without significantly reducing the size of the Avid 
application.

Using Alt+Tab to Restore Help (Windows Only)

To use Alt+Tab to restore Help:

1. Press and hold the Alt key.

2. Press and release the Tab key, but keep holding the Alt key.

A window opens containing icons and names for all the applications 
currently started on your system. A box surrounds the active 
application.

3. Continue to hold the Alt key and press and release the Tab key until the 
box surrounds the Help browser icon, and then release both keys.
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Finding Information Within Help

You see the Help browser when you open Help from the Help menu. The 
left frame of the Help browser includes a Contents list and buttons for 
several other methods of finding information.

Using the Contents List

The Contents button provides a list of topics covering the entire Help 
system.

To view the Contents list using the Contents button, do one of the 
following:

t From the Help menu, choose Avid Xpress DV Help, and then click the 
Contents button.

t From a Help topic, click the Contents button.

To display a topic, double-click the topic title in the Contents list.

n (Macintosh only) The Contents displays only the top-level topics. Many 
entries link to subtopics with related information or procedures.

You can print a topic by clicking the right mouse button and choosing Print 
from the pop-up menu.

Using the Index

The Index button provides an alphabetized list of entries, like the index of a 
printed book.

To find topics using the Index button:

1. From the Help menu, choose Avid Xpress DV Help, and then click the 
Index button (or click the Index button from a Help topic).

2. From the alphabet at the top, select the letter that begins the topic you 
want to find (for example, click A to jump to index entries listed under 
audio).

3. Scroll through the topics beginning with that letter until you find the 
topic you want.
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4. Click the number to the right of the index entry. The number indicates 
how many topics that index entry has associated with it.

The topic opens in the right frame of the browser.

Using the Search Feature

The Search button lets you search the entire Help system for words or 
phrases, and then lists topics that include those words or phrases.

To search for topics using the Search button:

1. From the Help menu, choose Avid Xpress DV Help, and then click the 
Search button (or click the Search button from a Help topic).

2. In the text box, type the word or phrase you want to find. You can type 
up to three words, not including invalid words like “the” or 
misspellings.

3. Press Enter (Windows) or Return (Macintosh) or click the Search 
button.

A list shows topics that contain the word or words for which you 
searched.

n Do not type quotation marks or asterisks in the text box.

4. Click a topic in the list.

The topic opens in the right frame of the browser.

Using the Glossary

The Glossary defines and explains many terms common to the industry. 
Some entries might not apply to your particular system.

To use the Glossary:

1. Click the Glossary button.

2. Click the letter that begins the term or concept for which you are 
searching.

3. Scroll through the section to find your term.

4. Click links to see related information.
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Printing Help Topics

You can print a Help topic if you need to refer to it during a complicated 
procedure or for reference later.

To print a Help topic:

1. Open or click the topic to make it active.

2. Choose Print from the browser File menu, or click the Print button in 
the browser toolbar.

3. Select the print options.

4. Click OK (Windows) or Print (Macintosh).

(Windows only) You can print a topic by clicking the right mouse button 
and choosing Print from the pop-up menu.

Using Online Documentation

The Avid Xpress DV Online Publications CD-ROM includes:

• Avid Xpress DV User’s Guide

• Avid Xpress DV Effects Guide

• Avid Xpress DV Getting Started Guide (this book)

• Avid Color Correction User’s Guide

• Avid EDL Manager User’s Guide

• Avid FilmScribe User’s Guide (optional software)

• Avid IllusionFX Guide (optional software)

• Avid Xpress DV User’s Guide Supplement

• Avid Xpress DV Tour

• Avid Xpress DV Help

The books are PDF files. You can view them with the 
Adobe Acrobat Reader, which you can install from the CD-ROM.
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The online version of the books enables you to:

• Navigate through books using bookmarks and hyperlinks.

• Speed up information retrieval by performing keyword searches.

• Annotate the books with your own notes.

• Zoom in on a page, enabling closer review of text and images.

• Print any or all pages.

• View the books with full-color graphics.

• View movies that illustrate Avid Xpress DV effects.

n Avid gives you permission to print up to three complete copies of each 
book.

Tips and Other Resources

The following are a few tips for taking full advantage of the Avid Xpress 
DV documentation and other resources:

• Complete the tutorial chapters in this guide before starting a project.

• Begin learning about basic procedures using the default settings. As 
your confidence increases, explore additional procedures and settings.

• Instead of using the standard menus to find the command you need in a 
window, try using shortcut menus. Using the right mouse button 
(Windows only), click in a window to open a shortcut menu that shows 
the most frequently used commands for that window.

• Keep the Avid Xpress DV Quick Reference for your specific platform 
available during editing sessions. 

• Read Avid’s newsletters, mailings, and other trade publications.

• Make use of additional training resources provided by Avid whenever 
possible, such as classes and instructional videotapes. For more 
information, contact Avid at 800-867-2843.

• Check the following Avid Web site for listings of courses, schedules, 
and locations:

www.avid.com/training/courses
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Chapter 5

Starting a Project

In this chapter, you start the application and then select a project.

n Before starting the tutorial, make sure you have installed the tutorial files 
(see “Installing the Avid Xpress DV Tutorial Files (Windows)” on page 50 
and “Installing the Avid Xpress DV Tutorial Files (Macintosh)” on 
page 60).

This chapter contains the following sections:

• Starting Avid Xpress DV (Windows)

• Starting Avid Xpress DV (Macintosh)

• Changing Users

• Using User Profiles

• Selecting a Project

• Viewing Clips

• Closing the Project and Quitting the Application
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Starting Avid Xpress DV (Windows)

You can create a 
shortcut on the desktop 
and start the application 
by double-clicking the 
icon. See your 
Windows  
documentation.

You start the Avid Xpress DV application the same way you start most 
Windows applications. 

1. Click the Start button.

2. Point to Programs, point to Avid, and select Avid Xpress DV.

The first few times you start Avid Xpress DV, a window opens that 
contains the License Agreement.

3. To accept your Avid Xpress DV product license electronically:

a. Read the License Agreement, and then click the Yes button or the 
No button at the bottom of the screen.

The agreement appears the first several times you start 
Avid Xpress DV. After several starts, a new button appears at the 
bottom of the screen labeled Yes, and Don’t Show Again.

b. If you don’t want to see the License Agreement again, click the 
Yes, and Don’t Show Again button.

A dialog box appears.

c. Enter the name of your organization in the dialog box, and click 
OK.

After you accept the License Agreement, the Product Registration 
dialog box appears. This allows you to register your Avid Xpress DV 
product.

4. To register your Avid Xpress DV product:

a. Register Online - Opens a Web browser with the Avid Xpress DV 
Product Registration form. Fill out the form and click Submit.
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b. Display Registration Form to Print - Opens the Avid Xpress DV 
Product Registration form and allows you to print the form, fill it 
out, and then mail it back to Avid.

c. Don’t Register Now - Click this button if you do not want to 
register your product at this time.

n You can also obtain the online and printable version of the Avid Xpress DV 
Product Registration form from within the Avid Xpress DV application. 
Choose Product Registration from the Help menu and then select either the 
“Register Online” or the “Display Registration Form to Print” option.

After you register, the Select Project dialog box appears.

The Saturn project you installed in the Avid Projects folder in Chapter 2 
appears in the Projects scroll list.

The name you used to log on to your Windows system is selected as the 
user.

You can change users. You can select projects from the Select Project 
dialog box, or choose to have your last project open automatically. You can 
also establish user profiles.



 Chapter 5 Starting a Project

108

Starting Avid Xpress DV (Macintosh)

To start the application:

1. Double-click the Avid icon alias on the desktop.

The first few times you start Avid Xpress DV, a window opens that 
contains the License Agreement.

2. To accept your Avid Xpress DV product license electronically:

a. Read the License Agreement, and then click the Yes button or the 
No button at the bottom of the screen.

The agreement appears the first several times you start 
Avid Xpress DV. After several starts, a new button appears at the 
bottom of the screen labeled Yes, and Don’t Show Again.

b. If you don’t want to see the License Agreement again, click the 
Yes, and Don’t Show Again button.

A dialog box appears.

c. Enter the name of your organization in the dialog box, and click 
OK.

After you accept the License Agreement, the Product Registration 
dialog box appears. This allows you to register your Avid Xpress DV 
product.

3. To register your Avid Xpress DV product:

a. Register Online - Opens a Web browser with the Avid Xpress DV 
Product Registration form. Fill out the form and click Submit.

b. Display Registration Form to Print - Opens the Avid Xpress DV 
Product Registration form and allows you to print the form, fill it 
out, and then mail it back to Avid.
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c. Don’t Register Now - Click this button if you do not want to 
register your product at this time.

n You can also obtain the online and printable version of the Avid Xpress DV 
Product Registration form from within the Avid Xpress DV application. 
Choose Product Registration from the Help menu and then select either the 
“Register Online” or the “Display Registration Form to Print” option.

After you register, the Select Project dialog box appears.

The Saturn project you installed in the Avid Projects folder in Chapter 2 
appears in the Projects scroll list.

The name you used to log on to your Macintosh system is selected as the 
user.

You can change users. You can select projects from the Select Project 
dialog box, or choose to have your last project open automatically. You can 
also establish user profiles.
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Changing Users

To change Avid Xpress DV users:

1. Quit Avid Xpress DV.

2. Do one of the following:

t (Windows) Press Ctrl+Alt+Delete, click the Log Off button, and 
then log on as a different user.

t (Macintosh) Choose Log Out from the Apple menu, click Log 
Out, and then click a new user.

n (Macintosh only) You have to create a new user before you can change to 
that user. See your Macintosh documentation or the Macintosh Help.

3. Start Avid Xpress DV.

Your current login name appears as the user in the Select Project dialog 
box.

You can select projects from the Select Project dialog box, or choose to 
have your last project open automatically.

Using User Profiles

You can establish different profiles for a single user without having to log 
out of your system and then having to log back in under a different name 
(see “Changing Users” on page 110). You might want separate editing 
functions to have separate settings. User “Kim,” for example, can have 
separate profiles for “Audio editor,” “Film editor,” or for “Assistant 1,” 
“Assistant 2,” and so on. These profiles have separate folders and settings 
that are kept in the Users/UserName folder.
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Creating a User Profile

To create a user profile:

1. Click the Settings tab in the Project window.

2. Choose Create User Profile from the User Profile Selection pop-up 
menu.

The Create User Profile dialog box appears.

3. Type a name in the Profile Name text box, and then click OK.

The new user profile appears selected in the pop-up menu, and the user 
profile name appears in the Project window title bar.

Changing User Profiles

To change a user profile:

1. Click the Settings tab in the Project window.

2. Choose a different profile from the User Profile Selection pop-up 
menu.

User Profile Selection
pop-up menu
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To return to the default user profile:

1. Click the Settings tab in the Project window.

2. Choose Default User Profile from the User Profile Selection pop-up 
menu.

n When you choose Default User Profile, your login name appears in the 
Project window title bar. When you choose another user profile, the user 
profile name appears in the Project window title bar.

Selecting a Project

To select a project:

1. Select Saturn from the Projects scroll list, and click OK.

If the Saturn project does not display in the Projects scroll list, you 
might have installed it to a different location. Click the Browse button 
and locate the Saturn project.

The Project window opens. It displays the Saturn bin.

2. Double-click the bin icon to open the Saturn bin.

This bin contains the clips you need to build the tutorial sequence.

Project window title bar

Bin
icon

To get Help for the 
Project window, click 
in the Project window 
and press the 
F1 key (Windows) or 
Help key (Macintosh).
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Viewing Clips

You can use four views for working with clips in a bin: Brief view, Text 
view, Frame view, and Script view:

• Brief view displays only five standard columns of information about 
your clips and sequences. 

• Text view displays many columns of information about your clips and 
sequences.

• Frame view displays each clip as a single representative image.

• Script view displays each clip with an image and an area in which to 
enter text as part of a storyboard.

Text tab
Script tab

Frame

Brief
tab

tab
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Using Brief View

Let’s look at Brief view:

t Click the Brief tab in the upper left corner of the bin window to 
view brief information about clips in the Saturn bin.

Clips are displayed in a database text format that uses columns and 
rows, with icons representing the various objects. Brief view 
displays only five standard columns of information about your 
clips and sequences.

Using Text View

Let’s look at Text view:

Text view is the default 
bin setting.

1. Click the Text tab in the upper left corner of the bin window to view 
information about clips in the Saturn bin.

If the tab is highlighted, you are already in Text view.

In Text view, you can rearrange the clips in the bin by sorting on a 
particular column. Let’s first sort by Start time, and then sort by Name 
so the clips return to alphabetical order.

Column headings

Object icons

Brief tab

Bin Fast
Menu button
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2. Click the Start heading in the bin.

3. Choose Sort from the Bin menu.

The clips are rearranged according to Start time.

4. Click the Name heading in the bin.

5. Choose Sort from the Bin menu.

The clips are returned to alphabetical order.

Using Frame View

Frame view presents each clip as a single picture frame, with the name of 
the clip. You can play back the footage in each frame, change the size of 
frames, and rearrange frames in any order within the bin.

Let’s look at Frame view:

1. Click the Frame tab in the upper left corner of the bin window to see a 
picture-frame representation of each clip in the bin.

n The sorted order of clips does not carry over to Frame view.

Column headings

Object icons

Text tab

Bin Fast
Menu button
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2. Choose Enlarge Frame from the Edit menu.

3. If some clips are now off screen, choose Fill Window from the Bin 
menu.

The clips are arranged in neat rows and columns in the bin.

4. Click one of the clips, and press the L key (Play) on the keyboard.

The clip plays in the bin.

5. Press the space bar (Stop) to stop playing the clip.

Using Script View

Script view combines the features of Frame view with Text view and 
includes space for typing notes or script. The frames are displayed 
vertically on the left side of your screen with a text box to the right of each 
clip. Clip data is displayed above the text box.

Frame tab
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Let’s look at Script view:

1. Click the Script tab in the upper left corner of the bin window to see a 
picture-frame representation of each clip in the bin along with space 
for typing notes or script.

2. Click in the text box next to the Audio Track clip.

3. Type This audio track includes both music and 
voiceover.

4. Click the Text tab to return to Text view.

Script tab
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Closing the Project and Quitting the Application

To close the project and 
quit the application 
immediately, choose 
Exit from the File 
menu (Windows) or 
choose Quit from the 
AvidXpressDV menu 
(Macintosh), or click 
the Close button 
(Windows) or close box 
(Macintosh) in the Avid 
Xpress DV title bar.

If you want to close the project and quit the application:

1. Click the Project window to activate it, and then click the Close 
button (Windows) or close box (Macintosh).

The system saves and closes the project. The Select Project dialog box 
appears.

2. Click Quit.

A dialog box appears and asks if you want to quit the application.

3. Click Leave.

The application quits.

The next time you open the project, select your project name, and resume 
the tutorial with the next section.

You’ve completed this tutorial section. In Chapter 6, you’ll learn how to 
open, play, and mark a clip.



Chapter 6

Playing and Marking Clips

In the this chapter, you display and play several clips, you learn to mark 
footage, locate IN and OUT points, and create subclips in the Source 
pop-up monitor. This chapter contains the following sections:

• Exploring the Project Window

• Opening a Clip in the Source Pop-Up Monitor

• Using Toolsets

• Displaying Tracking Information

• Controlling Playback

• Opening and Using the Tool Palette

• Using the Command Palette

• Marking Edit Points

• Creating Subclips
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Exploring the Project Window

Click in the Project 
window and press the 
F1 key (Windows) or 
Help key (Macintosh) 
to open Help for the 
Project window.

The Project window must remain open whenever you are working in 
Avid Xpress DV. Depending on the tab you click, the Project window 
displays a list of bins, a list of settings, or information about your system.

n If the Project window becomes hidden by other windows, bring it forward 
by choosing Project from the Tools menu.

The Bins Display

The Bins display lists the bins, or storage areas, created to hold your clips 
and sequences (you’ll learn more about bins later in this chapter). For the 
Saturn project, there is only one bin.

The Settings Display

For more information, 
see the Avid Xpress DV 
User’s Guide or press 
the F1 key (Windows) 
or Help key 
(Macintosh) for Help.

Click the Settings tab at the top of the Project window. A list of settings 
appears. This list is called the Settings scroll list. Settings are groups of 
options you can select, depending on your needs and preferences.
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The right column displays the type of setting. User settings are associated 
with the current user, and Project settings are associated with the project. 
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Especially important for Avid Xpress DV are the Video Display settings. 
Check the settings now.

1. Scroll down the list of settings and double-click Video Display.

The Video Display Settings dialog box appears.

The top part of the dialog box gives you a choice for how to display 
video on your desktop.

2. If you have a Client monitor (a separate monitor that displays NTSC or 
PAL video) and camera attached to your system, and you want to view 
the video on the Client monitor, select the “DV device supports digital 
video input” option.

3. Then select the “Send video to DV device (client monitor enabled)” 
option.

This option might already be selected.

4. Click OK to close the Video Display Settings dialog box.
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The Info Display

Click the Info tab at the top of the Project window. You see the format of 
the project (NTSC or PAL). You can get information about your system by 
clicking the Hardware or Memory button.

Click the Bins tab to return to the Bins display.

Opening a Clip in the Source Pop-Up Monitor

When you double-click a clip in a bin, it is loaded by default into the 
Source pop-up monitor. You can also load a clip by clicking the clip icon 
and dragging it from the bin to the Source pop-up monitor.

To open the CU chick clip:

t Double-click the CU chick clip icon in the Saturn bin.

Hardware and 
Memory buttons
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The CU chick clip is highlighted in the bin and appears in the Source 
pop-up monitor.

Using Toolsets

You can use predesigned work environments that are suited to your most 
common Avid Xpress tasks: 

• Basic

• Source/Record Editing

• Effects Editing

• Audio Editing

• Recording

Tracking
Information
display
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The Toolset menu provides you with five environments, or special-purpose 
workspaces, that include the following:

• Tools appropriate for the task

• A screen optimized for the task, screen resolution, and number of 
monitors

• A neatly organized workspace with nonoverlapping windows

You can change the toolset workspace, restore it to the default 
arrangement, or link it to other settings. For example, you might want each 
toolset to appear with a different color scheme.

Opening Toolsets

To open a toolset:

t Choose a toolset from the Toolset menu.

Any open tools close and the screen changes to display windows 
appropriate to the toolset task.

Source/Record Editing Toolset

The Source/Record Editing toolset displays the Composer monitor as dual 
monitors. You edit source clips in the left monitor and sequences in the 
right monitor. You will be using the Source/Record Editing toolset 
throughout this tutorial

n For more information about all the toolsets, see Chapter 3 in the 
Avid Xpress DV User’s Guide.

Displaying Tracking Information
For detailed 
information on 
Tracking Format 
options, see the 
Avid Xpress DV 
User’s Guide or Help.

Tracking information consists of any type of format used to identify clips, 
audio and video tracks, individual frames, or footage durations while you 
work. This information is updated continuously to reflect your current 
position in the footage. You can choose various alternative tracking 
formats from the Tracking Information menu.
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To access the Tracking Information menu:

1. With a clip loaded in the Source monitor, click the Tracking 
Information display above the Source monitor.

2. Choose TC, V1 from the Tracking Information menu.

A check mark means it is selected.

Controlling Playback

There are several ways to move through footage in the Source pop-up 
monitor:

• Use the mouse to move the position indicator in the position bar to go 
to a specific position or drag it to scroll through a clip.

• Use the playback control buttons under the Source pop-up monitor.

• Use the playback control keys on the keyboard.

Tracking Information menuTracking Information display
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Using the Position Bar and Position Indicator

You can quickly access frames within a clip that has been loaded into the 
Source pop-up monitor or move through the footage using the position 
indicator that appears in the position bar under the Source pop-up monitor. 
You can move the position indicator within the position bar under the 
Source pop-up monitor by clicking anywhere in the position bar or by 
dragging the position indicator to the left or right.

n The speed with which you drag the position indicator determines the speed 
at which you move through the footage.

To move through the clip using the position indicator:

1. Locate the vertical position indicator in the position bar under the 
Source pop-up monitor.

2. Click the position indicator and drag it back and forth in the position 
bar to move through the clip.

3. Click the position indicator and drag it to the left to go to the beginning 
of the clip.

4. Click the position indicator and drag it to the right to go to the end of 
the clip.

n As you move through footage, the Tracking Information display updates 
frame-by-frame.

Controlling Playback with Playback Control Buttons

Let’s use the playback control buttons to look at another clip:

1. Double-click the Hopping chicks clip in the Saturn bin.

The clip opens in the Source pop-up monitor.

Position
indicator

Position
bar
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2. Click the Play button under the Source pop-up monitor.

The buttons displayed 
under the Source 
pop-up monitor might 
be different. You can 
reassign buttons using 
the Command palette. 
See “Using the 
Command Palette” on 
page 131.

3. Click the Rewind button to go to the head frame of the clip.

4. Click the Step Forward button several times to move through the 
footage frame-by-frame.

5. Press and hold the Alt key (Windows) or Option key (Macintosh) 
while clicking the Step Forward button to step forward 10 frames.

6. Click the Fast Forward button to go to the tail frame of the clip.

7. Click the Step Backward button repeatedly to step backward 
frame-by-frame.

Controlling Playback with Playback Control Keys

The playback control keys on the keyboard allow you to play, step, and 
shuttle through footage at varying speeds. 

PlayStep
Backward 

Fast
Forward 

Rewind Step
Forward 

Stop 

Play/Step/Shuttle Step Forward Home key
End key
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Now let’s play through the Sunflowers clip using the playback control 
keys:

1. Double-click the Sunflowers clip to open it in the Source pop-up 
monitor.

2. Press the L key (Play) on the keyboard to play the clip forward at 
normal speed (25 or 30 fps).

3. Press the J key (Play Reverse) on the keyboard to play the clip 
backward at normal speed. 

4. Press the L key (Play) repeatedly to play the clip forward at 60, 90, 
150, and 240 fps (NTSC) or 50, 75, 125, and 200 fps (PAL).

5. Press the J key (Play Reverse) repeatedly to play the clip backward at 
60, 90, 150, and 240 fps (NTSC) or 50, 75, 125, and 200 fps (PAL). 

6. Press the space bar (Stop) to stop playback at any point.

7. Press and hold the K key while you press and hold the L or J key to 
move forward or backward at slow speed.

8. Press the 3 key (Step Backward 1) and 4 key (Step Forward 1) to step 
through the footage backward and forward in 1-frame increments.

9. Press the 1 key (Step Backward 10) and 2 key (Step Forward 10) to 
step through the footage backward and forward in 10-frame 
increments.

10. Press the Home key to go to the beginning of the clip.

11. Press the End key to go to the end of the clip.

Opening and Using the Tool Palette

Before you continue with your editing, familiarize yourself with the Tool 
palette. So far you have been using buttons that appear below the Source 
pop-up monitor or keyboard equivalents. The Tool palette provides you 
with additional buttons for navigating and editing. 
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Opening and Tearing Off the Tool Palette

You can also open the 
Tool palette from the 
Fast Menu button on a 
Source pop-up monitor.

Open the Tool palette by clicking the Fast Menu button under the 
Composer monitor.

To use a button on the Tool palette, just click it. You can also “tear off” the 
palette and drag it to a different location.

1. If the Tool palette is not open, click the Fast Menu button.

2. Click the pointer and drag it over the buttons and then outside the 
border of the Tool palette. You should see a dotted line outline. Click 
the outline and drag it to another location. You see the complete Tool 
palette, with a title bar and Close button (Windows) or close box 
(Macintosh).

You can click the Tool palette and drag it to a different location; just click 
and hold anywhere on the Tool palette and drag it wherever you want. You 
can also resize it to a square or a single row, to suit the way you want to 
work.

All buttons in 
Avid Xpress DV have 
ToolTips.

To view the name of each button, click the pointer and slowly drag it across 
each button. You should see a small yellow window pop up with the name 
of each tool. You’ve probably seen these pop-ups in other applications; 
they’re called ToolTips. 

Fast Menu button
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Displaying Button Names

You can display a shortened name on the button itself by selecting an 
option in the Interface Settings dialog box.

1. In the Project window, click the Settings tab.

2. From the Settings scroll list, double-click Interface.

The Interface dialog box appears.

3. Select the Show Labels in Tool Palette option from the General tab.

4. Click OK.

You see names on the first row of buttons. 

5. Click the border of the Tool palette and drag it until you see the second 
row of buttons. 

You can keep these names or remove them by deselecting the Show 
Labels in Tool Palette option from the General tab in the Interface 
dialog box. For this tutorial, you might want to keep the labels visible.

6. Close the Tool palette by clicking the Close button (Windows) or close 
box (Macintosh).

Using the Command Palette

The Command palette provides a central location for all user-selectable 
buttons (USBs) you can map to various locations for ease of use. User-
selectable buttons allow you to perform a wide range of commands with a 
single click.
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The Command palette groups buttons by editing function. Tabs are 
displayed for each function and the buttons that perform those functions 
are displayed within each tab (see Figure 20). The functions are: Move, 
Play, Edit, Trim, FX, 3D, Other, and More.

Figure 20 Command Palette Tabs

All buttons are displayed in the Command palette. If you cannot find a 
particular button, open the Command palette from the Tools menu and 
search for it there. For procedures on mapping user-selectable buttons and 
menu commands, see “User-selectable buttons:mapping” in the Help 
index.

Select To

‘Button to Button’ 
Reassignment

Map buttons to the Tool palette or any 
Command palette in a pop-up, Source, or 
Record monitor, and to reconfigure the 
keyboard.

‘Menu to Button’
Reassignment

Map menu commands to various buttons 
and keys.

Active Palette Use buttons directly from the Command 
palette without mapping them.
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Marking Edit Points

Before making your first edit, you can mark the segments of the clips you 
want to use in your sequence in the Source pop-up monitor.

Marking footage with IN and OUT points allows you to select which 
sections of a clip to include in a sequence.

There are two methods for marking IN and OUT points:

• Use the Mark IN and Mark OUT buttons under the Source pop-up 
monitor.

• Use the I key (Mark IN) and O key (Mark OUT) on the keyboard.

Using the Mark IN and Mark OUT Buttons to Mark a Clip

Let’s first display clips in the Source pop-up monitor, and then mark 
several clips we’ll use when we edit the sequence:

1. Double-click the Cowboy clip to open it.

The clip name is highlighted in the bin, and the clip appears in the 
Source pop-up monitor.

2. Play the whole clip through once first to get a sense of the material.

3. Press the Home key to go to the beginning of the clip.

4. Play the clip by pressing the L key (Play), and press the space bar 
(Stop) at the approximate place where the cowboy enters the frame. 

5. Use the Step Forward and Step Backward buttons under the Source 
pop-up monitor to locate the frame in which he is positioned directly 
below Calvin’s reflection in the rearview mirror.

6. Mark an IN point by clicking the Mark IN button under the Source 
pop-up monitor.
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A white sawtooth pattern appears on the left edge of the mark IN 
frame.

7. Step forward to the point just before the horse begins to leave the 
frame.

8. Mark an OUT point by clicking the Mark OUT button under the 
Source pop-up monitor.
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A white sawtooth pattern appears on the right edge of the mark OUT 
frame.

n The system saves your IN and OUT points until you change them.

Using the Mark IN and Mark OUT Keys to Mark a Clip

Next, let’s mark the IN and OUT points for the Restaurant scene clip 
using the Mark IN and Mark OUT keys on the keyboard.

1. Choose Source/Record Editing from the Toolset menu.

2. Two monitors (the Source on the left and the Record on the right) 
appear.

3. Double-click the Restaurant scene clip.

The clip opens in the Source (left) monitor. You want to show only the 
moment in which the waitress serves Calvin his coffee.

4. Use the J-K-L keys to locate the frame in which the waitress begins to 
tip the coffeepot.

5. Mark an IN point by pressing the I key (Mark IN) on the keyboard.
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A white sawtooth pattern appears on the left edge of the mark IN 
frame.

6. Press the End key to go to the end of the clip.

7. Mark an OUT point by pressing the O key (Mark OUT) on the 
keyboard.

A white sawtooth pattern appears on the right edge of the mark OUT 
frame.

Using Timecode as Reference

You can also use timecode as your reference point when marking IN and 
OUT points.

1. Double-click the CU with coffee clip to open it in the Source pop-up 
monitor.

2. Mark an IN point at 02:07:02:20 (NTSC) or 2:07:01:12 (PAL).

3. Mark an OUT point at 02:07:04:14 (NTSC) or 2:07:03:11 (PAL).
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Using Timecode to Find a Frame
Whenever you use the 
numeric keypad, you 
must press Enter on the 
numeric keypad after 
you type the number.

If you know the timecode for the frame you want to mark, you can go to 
that frame instantly by typing it on the numeric keypad.

1. Double-click the Hopping chicks clip to open it.

2. Using the numeric keypad, type 5422 (NTSC) or 708 (PAL).

As you start typing, a window opens in the middle of the Source 
pop-up monitor, showing the numbers.

3. Press Enter on the numeric keypad. 

When you press Enter, the position indicator locates the specified 
frame.

4. Mark an IN point.

5. Using the numeric keypad, type 5518 (NTSC) or 807 (PAL) and 
press Enter.

6. Mark an OUT point.
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Playing IN to OUT

Next, we’ll mark a clip and then take a look at the marked portion of the 
clip to make sure it is what we want:

1. From the bin, double-click the Zoom in Calvin clip to open it.

2. Mark an IN point at 1:04:28:03 (NTSC) or 1:02:14:03 (PAL).

3. Mark an OUT point at 1:04:30:00 (NTSC) or 1:02:16:02 (PAL).

4. Press the 6 key (Play IN to OUT) on the keyboard.

The clip plays from the IN point to the OUT point.

Moving an OUT Point

It would be nice to provide a little more footage of Calvin petting the 
chicks before the next clip.

1. Press the W key (Go to OUT) on the keyboard.

The position indicator moves to the OUT point.

2. Alt+drag (Windows) or Option+drag (Macintosh) the OUT point until 
Calvin looks up into the camera at approximately 1:04:30:23 (NTSC) 
or 1:02:16:12 (PAL).

3. Press the 6 key (Play IN to OUT) on the keyboard to review your edit.

The clip plays from the IN point to the OUT point.

Using Frame Offset

You can also use the numeric keypad to move the position indicator 
forward or backward a specified number of frames, with the frame offset 
feature. Let’s mark an IN point for the Car under bridge clip and then use 
frame offset to locate the OUT point:

1. Double-click the Car under bridge clip to open it.

2. Use the Play and Step buttons to locate the frame where the car 
appears to be directly under the bridge.

3. Mark an IN point.
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4. To advance, type +61 and press Enter on the numeric keypad.

When using frame 
offset, type one frame 
fewer than the number 
of frames you want to 
advance.

5. Mark that frame as the OUT point.

6. Press the 6 key (Play IN to OUT) to view your edit.

Creating Subclips

When you mark footage with IN and OUT points, either you can save the 
entire clip along with the new marks, or you can create subclips based on 
the marks you set to break up longer master clips into smaller segments of 
selected footage. Creating subclips is a great way to organize your footage 
into manageable units.

Let’s create two subclips from a single clip:

1. Double-click the Prairie landscape clip to open it.

2. Scroll through the clip by clicking the Play button or by clicking the 
position indicator and dragging it. 

There are two separate scenes that can be copied into separate subclips.

3. Mark an IN point at the beginning of the silo scene.

4. Mark an OUT point approximately halfway through the clip, about 
three-fourths into the silo scene.

5. Click the Fast Menu button under the Source pop-up monitor.

6. Click the Make Subclip button to create a subclip.

A new item called Prairie Landscape.Sub.01 appears in the bin. The 
name is highlighted.

7. Type Silo and press Enter (Windows) or Return (Macintosh) to name 
the subclip.

8. With the Prairie landscape clip in the Source pop-up monitor, click 
the Clear Both Marks button under the Source pop-up monitor to 
remove the IN and OUT points.

9. Mark an IN point in the clip near the beginning of the field scene.
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10. Mark an OUT point at the end of the clip.

11. Alt+click (Windows) or Option+click (Macintosh) the clip, and drag it 
from the Source pop-up monitor to the bin.

The clip name is highlighted in the bin.

12. Type Field and press Enter (Windows) or Return (Macintosh).

You’ve completed this tutorial section. In Chapter 7, you’ll learn how to 
edit marked clips into a sequence.



Chapter 7

Creating a Sequence

In this chapter, you create and build a sequence by splicing clips in the 
Source pop-up monitor into the Record monitor. This chapter contains the 
following sections:

• Building a Sequence

• Navigating in the Timeline

• Adding Audio

• Reviewing the Sequence

Building a Sequence

You create a sequence by splicing a clip from the Source pop-up monitor 
into the Record monitor. Let’s use the WS prairie clip for the opening clip 
in the sequence:

1. Double-click the WS prairie clip to open it in the Source pop-up 
monitor.

2. Mark an IN point about 2 seconds into the clip.

3. Mark an OUT point 1:10 seconds later.

4. Click the yellow Splice-in button from the Edit tab in the Command 
palette.
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The footage you marked in the Source pop-up monitor is displayed in 
the Record monitor and track V1 in the Timeline. You’ve just created a 
sequence consisting of a single clip.

Naming the Sequence

Your newly created sequence appears in the Saturn bin.

By default, the system names it Untitled Sequence.01. Let’s change this 
name:

1. Click the name Untitled Sequence.01 to select it; do not click the 
Sequence icon.

The name is highlighted.

2. Type Saturn Spot and press Enter (Windows) or Return 
(Macintosh).
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Using the Splice-in Key

Next, we’ll splice the Zoom in Calvin clip into the sequence:

1. Double-click the Zoom in Calvin clip in the bin to open it in the 
Source pop-up monitor.

2. Press the V key (Splice-in) on the keyboard.

The second clip is now edited into the sequence.

Navigating in the Timeline

When you create a new sequence or load a sequence in the Record monitor, 
the sequence appears in the Timeline.
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The Timeline provides various controls for quickly moving through a 
sequence and adjusting your view of details displayed in the tracks while 
editing.

The position indicator in the Timeline marks your place in the sequence. 
The Timeline’s position indicator is always in the same position as the 
Record monitor’s position indicator and works in the same way.

Let’s use the position indicator to move through the Timeline:

1. Move the position indicator to the beginning of the sequence by 
clicking in the left side of the Timeline.

2. Play through the first two clips.

3. Click the position indicator and drag it through the footage at varying 
speeds.

n When you move the position indicator in the Timeline, the smaller position 
indicator within the Record monitor’s position bar also moves.

Splicing a Clip into the Middle of a Sequence

You can splice a clip anywhere in your sequence. Let’s see what the Car 
passing sign clip looks like between the first and second clips:

1. Double-click the Car passing sign clip to open it in the Source pop-up 
monitor.

2. Mark IN and OUT points to mark 3 seconds of the car driving past the 
sign.

Timecode
track

Position indicator
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3. Ctrl+click (Windows) or k+click (Macintosh) within the Zoom in 
Calvin clip in the Timeline to move the position indicator to the first 
frame of the Zoom in Calvin clip.

4. Press the V key (Splice-in) on the keyboard.

n Wherever you splice a clip into the middle of a sequence, the rest of the 
sequence moves down. Splicing lengthens the material on the track.

5. Go to the head of the sequence and play through it to review your 
changes.

Undoing an Edit

The Car passing sign clip doesn’t seem to fit here. Let’s undo the last edit:

t Choose Undo Splice-in from the Edit menu.

Use the Undo feature whenever you feel you have made a mistake or want 
to go back a step. You can undo or redo up to 32 previous actions listed in 
the Edit menu.

n You can also perform an Undo by pressing Ctrl+Z (Windows) or k+Z 
(Macintosh).

Using the I/O (IN Point / OUT Point) Tracking Display

Let’s add two more clips to the sequence:

1. Double-click the Silo clip to open it.

2. Mark an IN point about one-fourth of the way through the clip.

3. Mark an OUT point 2 seconds later by following this procedure:

a. Choose I/O from the Tracking Information menu (under the top 
row of timecode) in the gray area above the Source pop-up 
monitor.

The I/O option displays the duration from the IN to OUT points. If 
you mark only the IN point, the I/O option displays the duration 
from the IN point to the position indicator.
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b. Step forward until the I/O display reaches 2:00, and mark an OUT 
point.

4. Move the position indicator to the first frame of black after the Zoom 
in Calvin clip.

5. Press the V key (Splice-in) on the keyboard to splice the clip into the 
Timeline as the third clip. 

6. Double-click the Field clip to open it.

7. Mark an IN point a little less than halfway through the clip.

8. Mark an OUT point 1 second later.

The I/O display reads 1:00.

9. Splice the Field clip into the Timeline as the fourth clip.

10. Choose Dur from the Tracking Information menu.

11. Go to the head of the sequence, and play through it to see your work.

Adding Audio

Next we’ll lay down the audio clip, which contains the sequence’s music 
and narration. You mark approximately 1 minute of the clip, which will be 
the duration of your finished sequence. 

Using Digital Audio Scrub to Locate an Audio Frame

Digital audio scrub enables you to locate a specific frame of audio. In this 
procedure, we use digital audio scrub to locate the first frame of music in 
the audio clip.

1. Double-click the Audio track clip to open it.

The clip appears in the Source pop-up monitor.

n Because it is audio only, the clip appears as black.

2. Play the clip through once.

3. Press the Home key to go to the beginning of the clip.
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4. Press the Caps Lock key to activate digital audio scrub.

5. Press the 3 and 4 keys (Step Backward and Step Forward) on the 
keyboard to locate the first frame of the music, and click the Mark IN 
button.

n When you use the Step keys, a frame of music or speech sounds scratchy or 
buzzlike. You might want to increase the volume of your speakers to hear 
the first frame of music.

6. Go forward exactly 1 minute by typing +10000 and pressing Enter on 
the numeric keypad.

7. Mark that frame as the OUT point.

8. Press the Caps Lock key again to deactivate digital audio scrub.

n Always turn Caps Lock off after using digital audio scrub. Leaving Caps 
Lock on while editing can slow down your system.

Splicing an Audio Clip 

To splice the audio clip into the sequence:

1. Move the Timeline position indicator to the head of the sequence.

2. In the Timeline, deselect track V1; select tracks A1 and A2.

3. Click the yellow Splice-in button from the Edit tab in the Command 
palette.

The audio track appears in tracks A1 and A2 of the Timeline. The 
sequence also appears in the Record monitor (the audio track appears 
black). 
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Reviewing the Sequence

Let’s review the sequence:

1. Press the Home key to go to the head of the sequence.

2. Click the Play button under the Record monitor to play the audio.

This audio track should run the length of the sequence, and its duration 
should be approximately 1 minute.

You’ve completed this tutorial section. In Chapter 8, you’ll add additional 
clips to the sequence and will refine your edits.



Chapter 8

Refining the Edit

Refining edits tightens and improves the relationship between pictures and 
sound. In this chapter, you add clips to the sequence using storyboard 
editing. You then refine the sequence rearranging several clips. This 
chapter contains the following sections:

• Overwriting Clips into a Sequence

• Using Storyboard Editing

• Rearranging Clips

• Removing Footage from a Sequence

Overwriting Clips into a Sequence

In addition to splicing, you can overwrite clips into a sequence. An 
overwrite edit replaces a section of a sequence with other source footage. 
An overwrite edit does not affect the length of the sequence.

The Field clip is a bit too long. In this section, we’ll edit the next clip into 
the sequence before the end of the Field clip:

1. In the Timeline, select track V1; deselect tracks A1 and A2.

2. Click the Record monitor’s top row of tracking information.

3. Choose TC, V1 from the Tracking Information menu.
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4. Move the position indicator in the Timeline to the first frame of the 
Field clip by Ctrl+clicking (Windows) or k+clicking (Macintosh) 
between the Silo and Field clips.

5. Advance by typing +20 (NTSC) or +13 (PAL) and pressing Enter on 
the numeric keypad.

6. Mark an IN point.

 

7. Double-click the CU chick clip to open it. 

8. Mark an IN point in the first half of the clip, at the point where the 
chick appears to be in the center of the frame and looking straight into 
the camera, approximately 1:05:58:00 (NTSC) or 1:00:43:11 (PAL). 

9. Mark an OUT point 1 second and 15 frames later when the chick looks 
sharply to the right.

10. Click the red Overwrite button from the Edit tab in the Command 
palette.

c Don’t confuse the Overwrite button with the Lift/Overwrite button. 
The Overwrite button is located between the Source and Record 
monitors; the Lift/Overwrite button is located under the Timeline.

The clip overwrites the end of the Field clip and extends beyond it, 
thus lengthening the video portion of the sequence.

You now have five video clips in your sequence.

 IN point
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Using Storyboard Editing

Storyboard editing allows you to set up a group of clips in a sequence of 
events and then load them into the Record monitor all at once.

To add multiple clips to your sequence:

1. Load the Car LS down road clip into the Source pop-up monitor, and 
mark an IN point at 1:09:24:13 (NTSC) or 1:02:31:22 (PAL). 

2. Mark an OUT point at 1:09:27:17 (NTSC) or 1:02:34:24 (PAL).

You’ve set the IN and OUT points for nine clips. We’ve set the rest for 
you.

3. Display the bin in Frame view.

4. Choose Fill Window from the Bin menu to arrange the clips in the bin.

5. Click the Car LS down road clip, and drag it to a clear space in the 
lower left area of the bin.

6. Arrange the following clips (after Car LS down road) in two or three 
rows, from left to right, and top to bottom, to form the storyboard. 
Make sure you maintain the order of clips:

- Hopping chicks

- Cowboy

- Car under bridge

- Car in pasture

- Restaurant scene

- CU with coffee

- Sunflowers

- Children run out

- Car drives into sunset

- Car passing sign

- Driver screen right

- Wagon over bridge

Frame tab
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- Wagon angle past grain elevator

- CU climbing grain elevator

- Wagon drives into grain elevator

- Looking at chicks

- CU happy farmer

- Wagon LS down the road 

Now you’re ready to load the marked clips into the sequence.

7. Ctrl+click (Windows) or k+click (Macintosh) in the Timeline near 
the end of the CU chick clip.

8. Select the storyboarded clips all at once:

a. Move the mouse pointer in the bin to the blank area just to the left 
of the Car LS down road clip. 

b. Lasso the clips by dragging the pointer to the right and down, 
making sure to select all the storyboarded clips.
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A box forms as you move the mouse, starting next to the Car LS 
down road clip and ending at the last pointer position. All the 
names are highlighted in blue.

9. Alt+click (Windows) or Option+click (Macintosh) one of the clips (the 
image, not the name), and drag the group into the Record monitor. 

10. Release the mouse when a yellow arrow appears in the Record 
monitor. 

The clips are spliced into the sequence in the order you specified. 

11. Move the position indicator to the head of the sequence, and play the 
entire sequence. 

Rearranging Clips

You can rearrange clips by overwriting material, lifting material, or 
removing material. Overwriting material doesn’t change the length of the 
sequence. Lifting material leaves filler and doesn’t affect the length of the 
sequence. Removing material shortens the length of the sequence.

Overwriting with the Three-Point Edit

The three-point edit is an excellent way to replace a clip in a sequence. Use 
the Mark Clip key to select the clip in the sequence, and mark either an 
IN point or an OUT point in the source clip. The system calculates the 
exact duration of the source clip to insert.

Let’s replace the Car in pasture clip with the Car with cows clip to create 
a more interesting visual image:

1. To enlarge this area, in the Timeline:

a. Press the Home key.

b. Click the scale bar and drag it to enlarge the Timeline.

c. Click the scroll bar, and drag it to the right until you see the entire 
Car in pasture clip.

2. Move the position indicator to the Car in pasture clip.
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3. Press the T key (Mark Clip) on the keyboard.

The IN and OUT points appear at the head and tail of the clip in track 
TC1 in the Timeline; the marked segment is highlighted. The IN and 
OUT points also appear in the Record monitor’s position bar.

4. Double-click the Car with cows clip to open it in the Source pop-up 
monitor, and mark an IN point about 2 seconds into the clip.

5. Click the red Overwrite button to make the three-point edit.

The Car with cows clip replaces the Car in pasture clip.

6. Return to the previous Timeline view by doing the following:

a. Click the scale bar and drag it to the left.

b. Move the position indicator in the Record monitor to the head of 
the sequence.

7. Play the sequence to see the change.

Changing the Order of Clips in a Sequence

Let’s see what it looks like if we reverse the position of two clips in the 
sequence, Cowboy and Car under bridge:

1. Move the Timeline position indicator to the Car under bridge clip.

2. Press and hold the Alt key (Windows) or Option key (Macintosh), drag 
the Car under bridge clip to the left so it is directly in front of the 
Cowboy clip, and release the mouse button. 

The Cowboy clip now follows the Car under bridge clip.
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Removing Footage from a Sequence

You can remove footage from your sequence, and either close or retain the 
gap that results. Extract/Splice-in closes the gap, and Lift retains the gap.

Removing Footage and Closing the Resulting Gap

The Field clip is too static. Let’s remove it from the sequence and close the 
gap that results:

1. Click the yellow Segment Mode (Extract/Splice-in) button under the 
Timeline.

2. Click anywhere in the Field clip on track V1.

The clip is highlighted in purple.

3. Press the Delete key on the keyboard.

The selected clip is eliminated, and the surrounding clips close the gap.

4. Click the Extract/Splice-in button again to deselect the button and 
leave Segment mode.

Removing Footage and Retaining the Resulting Gap

Lift retains the gap after lifting footage from the sequence. Use Lift if you 
want to maintain the rhythm of a sequence or the synchronization of the 
video and audio tracks.

The Children run out clip plays for too long. Let’s use Lift to shorten the 
Children run out clip but maintain the same entrance point for the next 
clip:

1. Scroll through the Children run out clip and mark an IN point as the 
third child appears at the left of the screen.

2. Ctrl+Alt+click (Windows) or Ctrl+k+click (Macintosh) near the end 
of the Children run out clip to go to the last frame of the clip.

3. Mark an OUT point.

4. Choose the Command palette from the Tools menu.
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5. Click the Edit tab.

6. Click Active Palette.

7. Click the Lift button to remove the segment.

Later, we’ll determine what to put in its place.

You’ve completed this tutorial section. In Chapter 9, you’ll learn how to 
trim your sequence.



Chapter 9

Trimming

For more information 
on Trimming, see the 
Avid Xpress DV User’s 
Guide.

Trimming allows you to adjust incoming and outgoing frames of your clip. 
There are two types of trims: dual-roller and single-roller. This chapter 
contains the following sections:

• Dual-Roller Trimming

• Using Dual Rollers to Trim the Outgoing Clip

• Trimming the Windshield Clip

• Single-Roller Trimming

Dual-Roller Trimming

Dual-roller trims adjust both sides of a transition simultaneously, adding 
frames to one clip while subtracting frames from the adjacent clip. The 
total duration of the sequence does not change.

Let’s adjust the CU with coffee and Sunflowers clips so they match the 
pause in the narration:

1. If you are not already displaying dual monitors, choose Source/Record 
Editing from the Toolset menu.

2. Move the position indicator near the CU with coffee/Sunflowers 
transition, and click the Trim Mode button in the Timeline. 
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The position indicator snaps to the transition.

The Record monitor shows the last (tail) frame of the CU with coffee 
clip on the left, and the Source monitor shows the first (head) frame of 
the Sunflowers clip on the right.

New buttons appear below the trim windows.

3. Play the transition by clicking the Play Loop button.

The transition plays repeatedly.

4. To stop the playback loop, click the Play Loop button again.

5. Press the Caps Lock key on the keyboard so you can hear the audio as 
you trim.

Trim
transition

Outgoing video Incoming video

Frame
countersTrim frame buttons buttonPlay Loop
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To use digital audio scrub, make sure the Speaker icon on the Audio 
Track Monitor button is highlighted. Increase the speaker volume, if 
necessary.

6. If the Speaker icon is not highlighted, Alt+click (Windows) or 
Option+click (Macintosh) the A1 Audio Track Monitor button.

7. Click the Trim Left 1 Frame button under the Source monitor until you 
hear a pause in the narration immediately after Calvin says, “. . . some 
pretty rugged country” (NTSC) or “. . . the Saskatchewan river . . .” 
(PAL).

This adds frames to the tail of the outgoing clip and removes them 
from the head of the incoming one. The duration of the video track 
remains unchanged.

8. Play the transition again by clicking the Play Loop button.

9. Press the Escape key to exit Trim mode.

10. Press the Caps Lock key on the keyboard to turn off digital audio 
scrub.

Using Dual Rollers to Trim the Outgoing Clip

Let’s insert a clip to take the place of the filler we left in the sequence. You 
replace the filler with the Windshield clip. After we overwrite the clip into 
the sequence, we’ll trim it.

1. Move the position indicator at the end of the Children run out clip 
and at the beginning of the Car drives into sunset clip.

2. Double-click the Windshield clip to open it, and mark an IN point 
about halfway into the clip. Do not mark an OUT point.

3. Click the red Overwrite button from the Edit tab in the Command 
palette.

 
Speaker 
icon

Trim Right
1 Frame

Trim Left
1 Frame
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4. Click the Trim Mode button under the Timeline.

5. Use the Trim Left 1 Frame button to move the transition 5 frames 
earlier.

Trimming the Windshield Clip

In the next steps, you will trim the Windshield clip so it enters a little 
earlier.

1. Enter Trim mode by lassoing the Timeline tracks: 

a. Click the pointer above all the Timeline tracks just to the left of the 
Children run out/Windshield transition. 

b. Click the mouse and drag it down and to the right to surround the
transition.

The trim rollers appear.

2. Move the transition 16 frames (NTSC) or 20 frames (PAL) earlier by 
clicking the Trim Left 8 Frames (NTSC) or Trim Left 10 Frames 
(PAL) button twice.

The numbers change in the purple frame counters.

3. Click the Play Loop button.

Single-Roller Trimming

In the trims you have made so far, you trimmed both the head and the tail 
clips an equal number of frames, adding to one side and subtracting from 
the other. Now let’s trim the tail of the Zoom in Calvin clip without 
affecting the head of the Silo clip. This is called single-roller trimming.

Trim rollers
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Let’s use single-roller trimming to edit your sequence:

1. While still in Trim mode, advance to the Zoom in Calvin/Silo 
transition by repeatedly pressing the A key on the keyboard.

2. Click the left frame counter (A-Side Trim counter).

Your trim will affect only the outgoing clip, which is in the left Trim 
monitor. The left frame counter remains purple, while the right one is 
deselected.

3. Type –15 and press Enter on the numeric keypad to subtract 15 frames 
from the outgoing clip.

This moves the transition 15 frames to the left.

4. Advance to the CU chick/Car LS down road transition by pressing 
the S key on the keyboard twice.

5. Click the left frame counter (A-Side Trim counter), type +30, and 
press Enter on the numeric keypad.

Thirty frames are added to the outgoing clip.

6. Leave Trim mode by clicking the Trim Mode button again.

You’ve completed this tutorial section. In Chapter 10, you’ll learn how to 
add effects to your sequence.

Left frame
counter
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Chapter 10

Adding Effects

Avid Xpress DV offers many effects you can apply to your sequences. This 
chapter explains how to apply effects to transitions or segments (clips) in 
your sequence. After you have selected the effect and have applied it to a 
transition or segment, you can adjust the effect parameters to meet your 
requirements. This chapter contains the following sections:

• Adding a Dissolve Effect (Fade In)

• Dissolving Between Clips

• Creating a Picture-in-Picture Effect

• Creating a Freeze Frame

• Screening the Sequence

Adding a Dissolve Effect (Fade In)

First we’ll add a Dissolve effect (fade in) to a transition. An effect that is 
applied between two clips is called a transition effect.

1. Click the head of the sequence.

2. Click the Quick Transition button in the Timeline.
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The Quick Transition dialog box appears.

3. Create a 10-frame dissolve (fade-in), starting at the cut, by doing the 
following:

a. Choose Dissolve from the Add pop-up menu.

b. Choose Starting at Cut from the Position pop-up menu.

c. Type 10 in the Duration text box.

4. Choose the drive on which the effect media file should be stored from 
the Target Drive pop-up menu.

The default drive is the Effect Source Drive.

5. Click Add and Render to render the effect.

The system creates the media file of the video effect during the 
rendering process. It also places a Rendered effect icon in the Timeline 
where you added the effect.

6. Play the effect. 

The sequence now begins with a fade-in to the WS Prairie clip.
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Dissolving Between Clips

You can create a transition effect by adding a dissolve between the Car 
under bridge clip and the Cowboy clip.

1. Click the first frame of the Cowboy clip.

2. Click the Quick Transition button in the Timeline. 

The Quick Transition dialog box appears.

3. Create a 10-frame dissolve, centered on the cut, by doing the 
following:

a. Choose Dissolve from the Add pop-up menu.

b. Choose Centered on Cut from the Position pop-up menu.

c. Type 10 in the Duration text box.

4. Choose the drive on which the effect media file should be stored from 
the Target Drive pop-up menu.

The default drive is the Effect Source Drive.

5. Click Add and Render to render the effect.

6. Play the effect. Press the space bar to stop playback.

Creating a Picture-in-Picture Effect

Now we’ll add a Picture-in-Picture effect, so the odometer appears on-
screen when Calvin mentions how many kilometers he has traveled in his 
Saturn. 

A Picture-in-Picture effect is a multilayer segment effect. This means the 
effect is applied to the top layer of segments that contain two or more video 
tracks that will be played simultaneously.

This effect takes up two video tracks: V1 for the clip of the car and V2 for 
the odometer clip. First, you have to move the Odometer clip to track V2.
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1. Double-click the Odometer clip to open it in the Source pop-up 
monitor.

2. Click in the Timeline and add a new video track by choosing New 
Video Track from the Clip menu.

3. Deselect the V1 Track Monitor button.

4. Click the V1 Source Track button, and drag it to the V2 Record Track 
button.

5. Use the Step buttons under the Record monitor to move the position 
indicator about 10 frames into the Car under bridge clip.

6. Click the yellow Splice-in button from the Edit tab in the Command 
palette.

The clip appears on track V2.

7. Choose Effect Palette from the Tools menu.

8. Click the Blend category.

The Blend effects, including Picture-in-Picture, are displayed in the 
right pane.

9. Move the position indicator to the Car under bridge clip on track V2.

10. Click the Picture-in-Picture Effect icon in the Effect Palette and drag it 
to the Odometer clip on track V2.

Effect icon
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The Effect icon appears in the Timeline, and the odometer appears in a 
box midscreen.

Repositioning the Image

Let’s move the image:

1. Click the Effect Mode button in the Timeline to enter Effect mode.

Parameters for the Picture-in-Picture effect appear in the Effect Editor.

2. Click the image of the odometer. 

Drag handles (the dots at the edges and in the middle of the box) 
appear, and a white hand appears when the pointer is over a 
handle.

3. Click the drag handle in the middle of the picture, and drag the image 
to the lower half of the screen.

Foreground
image (V2)

Background
filler (V1)
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Adjusting Softness

Now let’s use one of the Picture-in-Picture parameters to soften the edge of 
the image.

1. Click the Soft slider in the Effect Editor.

You can also type 20 
on the numeric keypad.

2. Click the Soft slider and drag it to the right to a value of 20. 

Cropping the Image

Now let’s use another of the Picture-in-Picture parameters to crop the 
image:

1. Click the Crop triangular opener in the Effect Editor.

2. Set the following parameters for the Crop sliders:

- Top: 130

- Bottom: –590

- Left: 200

- Right: 0

Soft slider
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Adding Keyframes

To add dissolves within the Picture-in-Picture effect, you need to add 
keyframes. These let the system know this is the location in the 
Picture-in-Picture effect where you want to start the dissolve.

To add keyframes:

1. Click the V1 Record Track button.

2. Click the first keyframe in the Record monitor.

3. Click the Foreground Level slider and drag it all the way to the left to 
display 0.

4. Click in the Record monitor and type +5 on the numeric keypad. Press 
Enter on the numeric keypad to move the position indicator 5 frames 
after the first keyframe.

5. Click the Add Keyframe button under the Record monitor.

6. Click the Foreground Level slider and drag it all the way to the right to 
display 100.

7. Right-click (Windows) or Ctrl+Shift+click (Macintosh) the last 
keyframe.

8. Click the Foreground Level slider and drag it all the way to the left to 
display 0.

9. Click in the Record monitor and type –5 on the numeric keypad. Press 
Enter on the numeric keypad to move the position indicator 5 frames 
before the last keyframe.

10. Click the Add Keyframe button under the Record monitor.

11. Click the Foreground Level slider and drag it all the way to the right to 
display 100.

Last keyframe First keyframe
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Rendering the Effect

You must render the Picture-in-Picture effect to play it at full speed.

n You must render a non-real-time effect before it can be played. When an 
effect is rendered, the system stores the effect and its media file as a 
precomputed master clip (often referred to as a precompute). The system 
uses the precompute to play the effect at its normal speed.

To render the effect:

1. Click and hold the Fast Menu button from the Source monitor.

The Tool palette appears.

2. Click the Render Effect button.

The Render Effect dialog box appears.

3. Choose a target drive for the rendered media from the Drive pop-up 
menu.

4. Click OK.

5. After the effect is rendered, close the Effect Palette.

6. Return to Source/Record mode by clicking the Effect Mode button.

7. Click the V2 Track Monitor button.

8. Play the rendered effect.
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Creating a Freeze Frame

We’d like to end the sequence with the Saturn logo. To do this, we need to 
create a freeze frame from a static graphic of the logo.

To create a freeze frame: 

1. Load Saturn Logo.pic into the Source pop-up monitor.

2. Choose Freeze Frame and 5 Seconds from the Clip menu.

The Select Media Drive dialog box appears.

3. Select a drive.

4. Move the position indicator to the end of the first frame of black after 
the Car LS down road clip.

5. Splice the freeze frame into the sequence as the final clip.

Screening the Sequence

You’ve made quite a few changes. Now let’s take a look at the sequence:

1. Move the position indicator to the beginning of the sequence.

2. Click the Play button.

You’ve completed this tutorial section. In Chapter 11, you’ll learn how to 
add a title to your sequence.
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Chapter 11

Creating Titles

In this chapter, you create a title, edit it, and splice it into the sequence. 
This chapter contains the following sections:

• Creating a New Title

• Using Text Formatting Tools

• Saving a Title

• Editing the Title into the Sequence

Creating a New Title

To create a new title:

1. In the Timeline, move the position indicator to the 
second-to-last clip in the sequence, Wagon LS down road.

n Your Avid system saves into a bin each title you create. You can load a title 
into the Source pop-up monitor at any time or click the Title Effect icon 
and drag it from the bin to a segment in the Timeline. You can also click a 
title and drag it from the bin onto an existing title in the Timeline; this 
causes the existing title to be replaced. 
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n You can create a new title with or without a sequence in the Timeline. 
However, if you want to create a title with a video background, you can 
load a video clip into the Record monitor to use as a reference frame while 
you create the title. The video reference frame you select appears in the 
background of the Title tool while you create the title. The reference frame 
makes it easier to position text and objects exactly where you want them 
and to select colors from the frame to use in the text and objects.

2. Choose Title Tool from the Tools menu.

The Title tool opens.

3. Click below the car.

An insertion point appears.

4. Type A different kind of company, and press Enter 
(Windows) or Return (Macintosh).

5. Click underneath the newly entered text, type A different kind 
of car, and press Enter (Windows) or Return (Macintosh).

Using Text Formatting Tools

The text formatting tools control the appearance of text. If a text object is 
selected when you change an attribute, your Avid system automatically 
applies the attribute to the object. The text formatting tools allow you to 
change the font, style, point size, justification, kerning, and leading of your 
title.

Let’s change the formatting of our title text:

1. Alt+click (Windows) or Option+click (Macintosh) the Selection tool 
in the toolbar.

Object selection handles surround the title.

2. Click the Font Selection button, and choose Times New Roman from 
the Font pop-up menu.

3. Click the Font Size button, and choose 36 from the Font Size menu.
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4. Click the left side of the text object and drag it so the words A 
different kind of company appear on a single line. To drag the right 
side, click the middle handle on the right side of the text object and 
drag it to the right.

Repositioning Text

To reposition the title text:

1. With the Selection tool selected, click the title and drag it so it appears 
centered in the lower half of the screen.

2. Use the arrow keys to move the title one pixel at a time.

3. Center the Title by clicking the Center Text button.
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Changing the Color of Title Text

The Color Selection boxes control fill (Fill), shadow (Shad), and border 
(Bord) color respectively.

The following illustration shows the Color Selection boxes.

To change the color of the title text:

1. Click and hold the Color Selection box for Fill. 

The Title Tool Color Picker opens.

2. Click a red color.

The color is applied to the title.

Adding a Shadow

To add a shadow to the title text:

t Type 3 in the Shadow Depth text box.

The title shadow appears.

Changing the Color of a Shadow

To change the color of the shadow:

1. Click and hold the Color Selection box for Shadow. 

The Title Tool Color Picker opens.

2. Click a shade of white.

The color is applied to the shadow.

Color Selection boxes
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Softening a Shadow

To soften the shadow:

1. Choose Soften Shadow from the Object menu.

The Soft Shadow dialog box appears.

2. Type 10 in the Shadow Softness text box.

3. Click OK.

The shadow is softened.
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Saving a Title

To save your title:

1. Choose Save Title from the File menu.

The Save Title dialog box appears.

2. Type Saturn in the Title Name text box.

3. Click Save.

4. Close the Title tool by clicking the Close button (Windows) or close 
box (Macintosh).

The title appears in the Source pop-up monitor.
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Editing the Title into the Sequence

To add your title to your sequence:

1. In the Track Selector panel, make sure the V1, A1, and A2 Track 
Monitor buttons are deselected.

2. Click the V1 Source Track button, and drag it to the V2 Record Track 
button.

3. With the title clip loaded in the Source pop-up monitor, mark an IN 
point at the beginning of the clip and an OUT point at 1:00:05:00.

4. In the Record monitor, move the position indicator to the middle of the 
Wagon LS down road clip.

5. Click the red Overwrite button from the Edit tab in the Command 
palette.

This adds the title to track V2.

6. If necessary, trim the title so it ends at the last frame of the Wagon LS 
down road clip.

7. Play the finished sequence.

You’ve completed this tutorial section. In Chapter 12, you’ll learn about 
outputting video with your Avid system.
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Chapter 12

Generating Output

You’ve finished your sequence. Now you’re ready to create an output 
format and distribute it. Avid Xpress DV lets you output your sequence in 
many different formats. This chapter contains the following sections:

• Creating Files for a DVD

• Exporting a QuickTime Movie

• Outputting a Digital Cut to Tape

Creating Files for a DVD

You can put your sequence onto a digital video disc (DVD). Depending on 
your hardware and software, you can:

• (Windows) Burn the sequence directly to a DVD from 
Avid Xpress DV.

• (Windows) Create a DVD volume you can move to another system.

• (Windows) Use the Create DVD command to create the appropriate 
MPEG-2 and .wav files.
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• (Macintosh) Use the Send To DVD command to create:

- A QuickTime reference movie and an AIFF file for use in iDVD

- An MPEG-2 file and an AIFF file for use in DVD Studio Pro™

- Files for other DVD applications

n For information about exporting MPEG-2 and .wav files, see the 
Avid Xpress DV User’s Guide.

Creating Files for a DVD (Windows)

To create files for a DVD:

1. Before you begin creating the DVD files, create and select an MPEG-2 
export setting. 

2. Select a sequence in a bin.

3. Choose Create DVD from the File menu.

4. The Create DVD dialog box appears. Select one of the following 
options:

t Export MPEG-2 and WAV Files: Select this option if you want 
to export your sequence in a format that can be used by a DVD 
authoring package such as DVDit!™ by Sonic Solutions.

t Create DVD Volume on Disk: If you don’t have DVD writing 
hardware attached to your Avid system, you can select this option 
to create a DVD volume. Then you can move the DVD volume to a 
system that has DVD writing hardware and software.

t Create DVD Volume and Write to DVD: If you do have DVD 
writing hardware attached to your Avid system, you can select this 
option to create the necessary files and send them directly to the 
DVD writing hardware. Make sure the DVD writing hardware is 
connected and ready before you execute the command.

5. Select a folder in which to store the generated files.

6. Choose an MPEG-2 export setting from the Export Settings pop-up 
menu.
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7. (Option) Click the Modify button to make any changes to the export 
setting in the Export Settings dialog box.

8. Click OK to start the export.

A progress indicator shows your progress.

n The length of export depends on the length of the media you are exporting. 
For example, it might take more than an hour to export a 3-minute 
sequence.

During the creation process, the system renders all effects and creates 
MPEG-2 files from the video media. The system also creates .wav files 
from the audio media.

When you select the Create DVD Volume on Disk option, the system 
creates a folder named DVDVolume. This folder contains the following 
two folders:

• AUDIO_TS

• VIDEO_TS

Use the AUDIO_TS and VIDEO_TS folders with your DVD writing 
application to create the DVD.

n The system creates an additional folder for storing the DVDVolume folder. 
The name of this additional folder is based on the sequence name. You can 
check for the name of this folder in the Create DVD dialog box.

n The Create DVD Volume on Disk option also allows you to save the 
resulting MPEG-2 and .wav files. The system prompts you with a dialog 
box after the volume is created.
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Creating Files for DVD Studio Pro (Macintosh)

You can send your edited sequence or a master clip to the DVD Studio Pro 
authoring application.

To create files for DVD Studio Pro:

1. Install DVD Studio Pro.

2. Select a sequence, a master clip, or both in a bin. You can select 
multiple sequences or clips.

3. Choose Send To DVD from the File menu.

The Send To DVD dialog box appears.

4. Choose DVD Studio Pro.app from the Send To pop-up menu.
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n You can use Add Item to add other applications or an AppleScript® script 
to the Send To pop-up menu. For information about using the AppleScript 
provided in the Avid Goodies folder, see “Using an AppleScript to Create a 
DVD (Macintosh)” on page 186.

5. Select Auto Launch Application to start the DVD authoring 
application when the export is complete.

6. Click the Browse button to navigate to a destination for the exported 
files.

7. Select other options as described in Table 5.

Table 5 Send to DVD Dialog Box Options

Option Description

QT MPEG Settings When this option is selected, the QuickTime MPEG Encoder window 
opens and you can set the parameters for creating your MPEG file. For 
more information about the QuickTime MPEG Encoder window options, 
see the QuickTime documentation.

Use QuickTime for 
MPEG Encoding

Select this option to use the QuickTime MPEG Encoder.

Pixel Aspect Ratio The pixel aspect ratio allows you to apply a scaling to the video: 4:3 or 
16:9. The pixel aspect ratio allows you to control the display format 
without modifying the source file. The default is 4:3.

n If you select the Use QuickTime for MPEG Encoding option, you set 
the pixel aspect ratio in the QuickTime MPEG Encoder window.

Use Enabled Tracks When this option is selected (default), the system uses tracks that are 
enabled in the Timeline. To export the entire clip or sequence, deselect this 
option.

Use Marks When this option is selected (default), the system uses current IN and OUT 
points in the selected clip or sequence to determine starting and ending 
frames for the export. To export the entire clip or sequence, deselect this 
option.
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8. Click OK.

n You can continue to edit with Avid Xpress DV while the QuickTime MPEG 
Encoder processes your material. A long sequence can take several hours.

An MPEG-2 (.m2v) file and a stereo-interleaved, 48-kHz AIFF file are 
produced in the destination you specified. If you selected Auto Launch 
Application, the destination folder opens and the application starts.

9. Shift+click the .m2v file and the audio file, and drag them onto the 
DVD Studio Pro Assets window.

10. Change any parameters in DVD Studio Pro, and then burn the DVD. 
For more information about using DVD Studio Pro, see the DVD 
Studio Pro documentation.

Using an AppleScript to Create a DVD (Macintosh)

The Avid Goodies folder contains an AppleScript that facilitates your 
export to an MPEG-2 file. 

To export to DVD Studio Pro using the AppleScript:

1. Install DVD Studio Pro.

2. Select a sequence, a master clip, or both in a bin. You can select 
multiple sequences or clips.

3. Choose Send To DVD from the File menu.

The Send To DVD dialog box appears.

4. Choose SendToDVDStudioPro_script from the Send To pop-up menu.

5. Click OK.

Send To DVD starts the QuickTime MPEG Encoder with your last 
saved settings, exports your sequence, converts it to an MPEG-2 file, 
and opens it and the related audio file in a new project in DVD Studio 
Pro.
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Preparing the Sequence

Before you export your sequence, check the sequence to make sure you 
have selected and monitored the tracks you want to use.

1. Start Avid Xpress DV and open your final sequence.

2. Make sure the Track Selector panel has the following record tracks 
selected and monitored:

- V3

- V2

- V1

- A1

- A2

Track Selector buttons for these tracks should be purple. Track 
Monitor buttons should show a Monitor icon for track V3 and Speaker 
icons on tracks A1 and A2.

3. Clear any IN or OUT points in the sequence.

4. If you want, play some or all of the sequence to make sure it is the 
version you want to output.

Exporting a QuickTime Movie

Avid Xpress DV provides you with many options for outputting 
(publishing) your sequence in formats suitable for digital distribution. In 
this section, you’ll create a QuickTime movie, which is a format you can 
use for distribution on CD-ROM or over the World Wide Web. For 
information about using other formats, see the Avid Xpress DV User’s 
Guide or Help.
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Using the QuickTime DV Codec

To create the QuickTime movie, you’ll be using the DV codec that is built 
into the QuickTime software. A codec is software or hardware that 
compresses and decompresses digital media (the word codec is a 
combination of the words compressor and decompressor). The QuickTime 
DV codec creates media files that are readable within QuickTime 
applications. In the following procedure, the codec uses the size, 
resolution, and other parameters of the Avid Xpress DV sequence, which 
makes the export very fast.

When you select the Same as Source option, the QuickTime DV codec 
maintains the dimensions of the media (720 x 480 pixels for NTSC,
720 x 576 pixels for PAL), which might not be appropriate for some uses. 
For example, if the destination of your exported media is a multimedia 
title, you can change the screen dimensions or use another codec, such as 
Cinepak™. Alternatively, you can use the QuickTime DV codec to create a 
QuickTime file for further processing in another application.

n QuickTime software is installed when you install Avid Xpress DV software. 
You can also install it separately. See “Installing Avid Xpress DV Software 
(Windows)” on page 40 or “Installing Avid Xpress DV Software 
(Macintosh)” on page 52.

Exporting the Sequence

For complete 
information about 
exporting, see the 
Avid Xpress DV User’s 
Guide or Help.

To create a QuickTime or other digital movie, you need to export the 
sequence.

1. Prepare your final sequence as described in “Preparing the Sequence” 
on page 187.

2. In the bin, select your final sequence.

3. Choose Export from the File menu.
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The Export As dialog box appears with a default file name in the 
File name text box based on the file type. The Macintosh dialog box 
will look slightly different.

4. Click the Options button.

The Export Settings dialog box appears.

5. Choose QuickTime Movie from the Export As pop-up menu.



 Chapter 12 Generating Output

190

The dialog box changes to show options for exporting QuickTime. 

For more information 
about these options, 
press the F1 key 
(Windows) or 
Help key (Macintosh).

6. Select the following options:

- Use Enabled Tracks

- Same as Source

- Video and Audio

The Same as Source option maintains the size and resolution of the 
sequence. This option also informs the system to use the QuickTime 
DV codec to create the QuickTime movie (see “Using the QuickTime 
DV Codec” on page 188). 

7. Click Save As.



Exporting a QuickTime Movie

191

The Save Export Setting dialog box appears.

8. In the Setting Name text box change the name to QuickTime.

This setting will be saved in the Settings scroll list, and you can reuse it 
later.

9. Click OK.

10. Click Save in the Export Settings dialog box.

The Export As dialog box appears again, and the Export Setting 
pop-up menu shows QuickTime.

11. Select a folder to store your QuickTime movie. For this tutorial, the 
QuickTime movie requires approximately 220 MB of disk space, so 
pick a drive that has sufficient space.

12. Click Save.

Pop-up menu
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The Avid Xpress DV system creates the QuickTime movie. For this 
tutorial sequence, the processing takes about 1 minute. 

13. Play your movie using the QuickTime player. If QuickTime is properly 
installed, you can play the movie by double-clicking its icon. 

Using the default screen dimensions and DV codec creates a large 
QuickTime movie that is best suited for further processing in another 
multimedia development application. To change the screen size and 
other options, select the Custom option in the Export Settings dialog 
box. For more information, see the Avid Xpress DV User’s Guide or 
Help.

Outputting a Digital Cut to Tape

For information about 
connecting a camera or 
video deck, see 
Chapter 2.

Avid Xpress DV provides you with options for outputting your sequence to 
tape. This output is referred to as a digital cut. You can output to your DV 
camera or video deck, or, if you have a transcoder connected to the system, 
to a Betacam®, VHS, or other analog video deck. You can also output to an 
audio deck.

About Remote and Local Deck Control

The Digital Cut tool provides you with two options for controlling your 
deck:

• Remote: Allows you to control the deck using the deck controller in 
the Digital Cut tool. This option provides frame-accurate control when 
you record a sequence to tape. To use Remote deck control, you need a 
tape that includes timecode information (a prerecorded or blacked 
tape). For information on creating a prerecorded or blacked tape, see 
the instructions for your camera or deck.

• Local: Allows you to manually control the deck using the controls on 
the deck. This option is useful when you need to use non-Avid-
controlled decks, such as consumer-grade VHS or Hi-8, or if you do 
not have a tape with timecode.
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Changing the Timecode of the Sequence

Your sequence uses timecode that starts with 00;00;00;00 (NTSC drop-
frame timecode) or 00:00:00:00 (PAL timecode). 

n To record a digital cut to an NTSC DV camera or video deck, you need to 
use drop-frame timecode in your sequence.

You can change the timecode for the start of the sequence. This change 
prevents problems if you try to record a digital cut starting at or near the 
very beginning of a tape (00;00;00;00). For this tutorial, you’ll change the 
timecode so the sequence begins to record 30 seconds after the start of the 
tape.

1. Make sure a sequence is loaded in the Composer monitor.

2. Click the Composer monitor.

3. Choose Get Sequence Info from the File menu.

The Sequence Info dialog box appears.

You can change the 
default starting 
timecode in the General 
Settings dialog box.

4. In the Starting TC text box, edit the timecode so it reads 00;00;30;00 
(NTSC) or 00:00:30:00 (PAL).

5. Click OK.

The timecode displayed in the Timeline changes to match the new 
starting timecode.
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Configuring Your Camera or Video Deck

Before you record your digital cut, you need to select the camera or video 
deck you are using so you can control the camera or video deck through 
the Digital Cut tool. 

1. In the Project window, choose Deck Configuration from the 
Settings scroll list.

The Deck Configuration dialog box appears.

2. Click the Add Channel button.
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The Channel dialog box appears.

Channel refers to the signal path for deck control. If you have 
connected a DV camera or video deck that supports IEEE 1394, 
choose FireWire as the Channel Type and 1394 as the Port from the 
pop-up menus.

3. Click OK.

A message box asks if you want to automatically configure the 
channel.

4. Click No.

The Deck Configuration dialog box now includes a channel.

Channel
box
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5. Click the channel box to select the channel.

A red outline indicates the channel box is selected.

6. Click the Add Deck button.

The Deck Settings dialog box appears.

For information about 
all Deck Settings 
options, see the 
Avid Xpress DV User’s 
Guide or press the F1 
key (Windows) or Help 
key (Macintosh) for 
Help.

7. Choose the manufacturer and model of your camera or video deck 
from the Device pop-up menus. If you do not see the manufacturer or 
model, choose Generic from the first pop-up menu.

8. Click OK.

The Deck Configuration dialog box now shows the channel and the 
connected camera or video deck.

9. In the Deck Configuration dialog box, make sure the channel box is 
selected (outlined in red) and click the Apply button.

Your camera or video deck is now ready for recording.
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Recording a Digital Cut

Now you’re ready to record your sequence on tape.

1. Make sure your camera or video deck is properly connected (see 
Chapter 2) and turned on to the VTR setting.

2. Insert a tape that contains timecode (see “About Remote and Local 
Deck Control” on page 192).

3. Prepare your sequence by making sure you have selected and 
monitored the tracks you want to use (see “Preparing the Sequence” on 
page 187).

4. Choose Digital Cut from the Clip menu.

The Digital Cut tool opens.

5. Select the tape as follows:

a. If the Select Tape dialog box does not appear automatically, click 
the Tape Name button in the Digital Cut tool.
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b. Click the New button. 

The name New Tape appears in the dialog box. 

c. Type a name for your tape and press Enter (Windows) or Return 
(Macintosh) on the main keyboard.

d. Select the new tape name and click OK.

To get Help for the 
Digital Cut tool, press 
the F1 key (Windows) 
or Help key 
(Macintosh), or 
position the pointer on 
an object, click the 
right mouse button, and 
choose What This? 
(Windows) or Help key 
(Macintosh) from the 
pop-up menu.

6. Use the following settings in the Digital Cut tool:

a. Select the Entire Sequence option.

b. Select the Remote option to control the camera or video deck.

c. Choose Sequence Time from the pop-up menu to start the 
recording at a timecode existing on tape that matches the start 
timecode of the sequence. 

7. Select the video and audio tracks you want represented in the digital 
cut by using the Sequence Track buttons. The selected buttons should 
match the tracks you selected in your sequence. The Video Sequence 
Track button shows V2, which is the top video track selected.

8. Select the video and audio tracks to record on the tape using the Enable 
Track buttons. They should match the selected Sequence Track 
buttons.

9. Click the Play Digital Cut button.

A message box asks you to mount the destination tape in the video 
deck. If you have already inserted a tape, click OK.
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The system cues the video deck to the starting timecode of the 
sequence, and then plays and records the digital cut. The playback 
appears in the Client monitor (if one is connected).

To stop the recording at any time, press the space bar. When the 
sequence finishes playing, a message box informs you the digital cut is 
complete.

10. Click OK.

11. Close the Digital Cut tool.

Next Steps

You’ve generated your final output. In Chapter 13, you’ll learn how to back 
up your project.
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Chapter 13

Backing Up and Deleting a 
Project

Now that you’ve completed your sequence and created output, you might 
want to save your work. You can then delete the project to save space on 
your media drive or drives. This chapter contains the following sections:

• Backing Up Project Information

• Backing Up Media Files

• Deleting a Project Folder and Media Files

Backing Up Project Information

Project information and User settings are contained in folders. You can 
save these folders on a floppy disk or any kind of drive, including a 
network drive. 

The project folder does not include the media. It does include information 
about the sequences, bins, master clips, subclips, effects, and other 
components of the project.
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The Saturn project is a small one, so you can copy the information onto a 
floppy disk.

1. Insert a formatted floppy disk into your floppy drive (Windows) or a 
CD-ROM into your CD-ROM drive (Macintosh).

2. Minimize the Avid Xpress DV window to view the desktop.

3. Double-click the My Computer icon (Windows) or the Macintosh HD 
icon (Macintosh) and locate the Avid Projects folder.

The exact location of this folder depends on your installation. In most 
cases it is located in the Avid\Avid Xpress DV folder on an internal 
hard drive other than drive C (Windows) or in the Macintosh HD\Avid 
Projects folder (Macintosh).

4. Double-click the Avid Projects folder.

5. Select the folder for your project. The folder has the same name you 
see in the Select Project dialog box, in this case Saturn.

6. Copy the folder to the floppy disk (Windows) or CD-ROM 
(Macintosh) using any copying or burning technique. 

7. After the folder is copied, label the floppy disk (Windows) or 
CD-ROM (Macintosh) and store it in a safe place.

Backing Up Media Files

The OMFI MediaFiles folders on your media drives contain the individual 
media files created when you recorded source material.

The media files for the tutorial are stored on the tutorial CD-ROM that 
came with your system, so you don’t need to back them up. For other 
projects, the following are options for backing up media files:

• You can use the Consolidate feature to make copies of selected media 
files on a target hard drive connected to the system. For information on 
consolidating, see the Avid Xpress DV User’s Guide or Help.

• You can back up smaller projects to a removable storage device, such 
as a hard drive.

• You can archive larger media files and folders to a network storage 
device.
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Deleting a Project Folder and Media Files

If you are finished with the tutorial and you want to create free space on 
your drives, you can delete the project folder and media files. The project 
folder consists of information about the clips and sequences, but does not 
include the media. Media files consist of the recorded video and audio 
data, and are stored on your media drive or drives.

Deleting a Project Folder 

You can’t delete project information from within the Avid Xpress DV 
application. You need to quit the application and delete the project. 

If you are finished with your project, delete the project information by 
following these steps:

1. Quit the Avid Xpress DV application.

2. Double-click the My Computer icon (Windows) or the Macintosh HD 
icon (Macintosh) and locate the Avid Projects folder.

The exact location of this folder depends on your installation. In most 
cases it is located in the Avid\Avid Xpress DV folder on an internal 
hard drive other than drive C (Windows) or in the Macintosh HD\Avid 
Projects folder (Macintosh).

3. Double-click the Avid Projects folder.

4. Select the folder for your project, in this case Saturn.

5. Press the Delete key or click the folder and drag it to the Recycle Bin 
(Windows) or Trash (Macintosh). 

The Confirm Folder Delete dialog box appears and asks if you are sure 
you want to delete the folder (Windows only).

6. Click Yes (Windows only).

7. Empty the Recycle Bin (Windows) or Trash (Macintosh) to remove the 
files from the system.
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Deleting Media Files

The most efficient way to delete all media files for a project is using the 
Media tool. The Media tool is your window to the recorded video and 
audio data files stored on your media drives.

If you are finished with the tutorial, delete the project’s media files by 
following these steps:

1. Start the Avid Xpress DV application and open the project.

2. Choose Media Tool from the Tools menu.

The Media Tool Display dialog box appears.

3. Select the media drive for your media. To make sure the Media tool 
displays all your media, click the All Drives button.

4. Select the Saturn project.
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5. Select all three types of files:

- Master Clips

- Precompute Clips (which are rendered effects)

- Media Files

6. Click OK. 

The Media tool opens. Specific icons indicate the types of media files.

7. Choose Select All from the Edit menu.

All files are highlighted.

8. Press the Delete key.
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The Delete Media dialog box appears. The selected check boxes in the 
dialog box indicate you have selected all files for deletion.

9. Click OK.

A dialog box appears and asks if you want to delete the media files.

10. Click Delete.

The selected media files are deleted.

11. Quit the application.

Next Steps

Congratulations on completing the Avid Xpress DV Tutorial! We hope 
you’ve enjoyed this introduction to the Avid editing process. After 
mastering these skills, you can proceed to learn more advanced techniques, 
as described in the Avid Xpress DV User’s Guide, Avid Xpress DV Effects 
Guide, and Help.
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